Agilent 1100/1200 HPLC
ChemStation Operation

Course Number H4033A

Laboratory Manual
Notice

The information contained in this document is subject to change without notice.
Agilent Technologies makes no warranty of any kind with regard to this material, including but not limited to the implied warranties of merchantability and fitness for a particular purpose.

Agilent Technologies shall not be liable for errors contained herein or for incidental, or consequential damages in connection with the furnishing, performance, or use of this material.

No part of this document may be photocopied or reproduced, or translated to another program language without the prior written consent of Agilent Technologies, Inc.

Agilent Technologies, Inc
3750 Brookside Pkwy
Suite 100
Alpharetta, GA  30022

© 2007 by Agilent Technologies, Inc.
All rights reserved
Printed in the United States of America
# Table Of Contents

LAB EXERCISE: INTRODUCTION TO THE HPLC CHEMSTATION..... 1  
IN THIS LABORATORY YOU WILL: ................................................................. 2  
ACCESSING THE HPLC CHEMSTATION....................................................... 3  
CONFIGURATION EDITOR ............................................................................ 5  
SCHEDULER ................................................................................................ 6  
MAINTAINING THE WINDOWS 2000 WORKSTATION ................................. 8  
  Cleaning up Temporary Files ................................................................. 8  
  Repairing the Disk .................................................................................. 8  
  Disk Defragmentation ........................................................................... 9  
  Creating an Emergency Repair Disk ...................................................... 9  
MAINTAINING THE WINDOWS XP WORKSTATION .................................... 10  
  Cleaning up Temporary Files ............................................................... 10  
  Repairing the Disk ................................................................................ 10  
  Disk Defragmentation ......................................................................... 11  
  Creating an Emergency Repair Disk .................................................... 11  
WINDOWS FEATURES (WINDOWS 2000 OR XP) ....................................... 13  
  Windows Explorer ............................................................................... 13  
  Wallpaper and Screen Savers .............................................................. 14  
  Clipboard .............................................................................................. 15  
  Closing a Program that is Not Operational .......................................... 15  
LAB EXERCISE: ACQUISITION METHODS ............................................. 17  
IN THIS LABORATORY YOU WILL: .......................................................... 18  
PREPARATION ............................................................................................ 19  
PREPARING THE HPLC ........................................................................... 20  
PRIMING THE AGILENT 1100/1200 SOLVENT DELIVERY SYSTEM .......... 21  
CREATING AN ACQUISITION METHOD .................................................. 23  
PRACTICE ENTERING GRADIENTS ......................................................... 24  
SNAPSHOT ................................................................................................. 27  
LAB EXERCISE: QUALITATIVE DATA ANALYSIS ................................. 29  
IN THIS LABORATORY YOU WILL: ......................................................... 30  
GRAPHICS - SIGNAL OPTIONS ............................................................... 31  
GRAPHICS - ANNOTATION ..................................................................... 33  
WINDOW FUNCTIONS ............................................................................... 35  
PEAK PURITY ........................................................................................... 36  
AUTOMATED PEAK PURITY ................................................................. 38  
DISPLAYING SPECTRA ........................................................................... 39  
ISOABSORBANCE PLOT ............................................................................ 40  
3D PLOT ................................................................................................... 42
LAB EXERCISE: SPECTRAL LIBRARIES .................................................. 43
IN THIS LABORATORY YOU WILL: .......................................................... 44
BUILDING A LIBRARY .............................................................................. 45
LIBRARY SEARCHING ................................................................................ 47

LAB EXERCISE: OVERVIEW AND DIAGNOSTICS ................................. 49
IN THIS LABORATORY YOU WILL: .......................................................... 50
Overview of Equipment and Tools Used ...................................................... 50
Consumables .............................................................................................. 50
THE AGILENT 1200 FLOW PATH ............................................................... 51
ERROR MESSAGES AND THE LOGBOOK ................................................. 52
DIAGNOSIS VIEW ..................................................................................... 53
ROUTINE MAINTENANCE ........................................................................ 59
INSTRUMENT TESTS ................................................................................ 60

LAB EXERCISE: OVERVIEW AND DIAGNOSTICS FOR THE AGILENT-SL SERIES................................................................. 61
IN THIS LABORATORY YOU WILL: .......................................................... 62
Overview of Equipment and Tools Used ...................................................... 62
Consumables .............................................................................................. 62
THE AGILENT 1200 - SL FLOW PATH ......................................................... 63
ERROR MESSAGES AND THE LOGBOOK ................................................. 64
AGILENT LC DIAGNOSTIC TOOL ............................................................. 65
INSTRUMENT STATUS REPORT ............................................................... 69
ROUTINE MAINTENANCE ........................................................................ 70
INSTRUMENT TESTS ................................................................................ 71

LAB EXERCISE: INTEGRATION ................................................................. 73
IN THIS LABORATORY YOU WILL: .......................................................... 74
INTEGRATION PREPARATION .................................................................. 75
AUTO INTEGRATION .................................................................................. 76
INTEGRATE USING THE EVENTS TABLE .................................................. 77
ADDING TIMED EVENTS .......................................................................... 79
USING MANUAL EVENTS ......................................................................... 81

LAB EXERCISE: QUANTIFICATION ........................................................... 83
IN THIS LABORATORY YOU WILL: .......................................................... 84
PREPARATIONS ......................................................................................... 85
CREATING THE ACQUISITION METHOD ................................................... 87
DATA ACQUISITION-STANDARDS ............................................................ 89
INTEGRATION ........................................................................................... 91
SETTING UP SIGNAL DETAILS ............................................................... 93
BUILDING A CALIBRATION TABLE ......................................................... 94
SETTING UP LOW AND HIGH AMOUNT LIMITS FOR CALIBRATION STANDARDS .................................................. 96
SETTING UP QUALIFIERS (DIODE ARRAY ONLY) .................................... 97
TESTING THE CALIBRATION TABLE ...................................................... 98
LAB EXERCISE: RUNNING A SEQUENCE................................................ 99
IN THIS LABORATORY YOU WILL: .......................................................... 100
BUILDING A SEQUENCE ........................................................................ 101
SEQUENCE SUMMARY REPORTS .......................................................... 104
STARTING THE SEQUENCE .................................................................... 105
PAUSING A SEQUENCE .......................................................................... 106
POST SEQUENCE .................................................................................. 107

LAB EXERCISE: SEQUENCE REVIEW AND REPROCESSING .......... 109
IN THIS LABORATORY YOU WILL: .......................................................... 110
REPROCESS WITH SEQUENCE FOLDER METHOD ................................ 111
REPROCESS WITH DA METHODS ......................................................... 117
BATCH REVIEW .................................................................................... 121

LAB EXERCISE: ADVANCED REPORTING ........................................... 123
IN THIS LABORATORY YOU WILL: .......................................................... 124
ADDING A REPORT HEADER ............................................................... 125
PERFORMANCE REPORTS (SYSTEM SUITABILITY) ............................... 127
AUTOMATED PEAK PURITY ................................................................. 129
AUTOMATED SPECTRAL LIBRARY SEARCH ....................................... 130

LAB EXERCISE: CUSTOMIZED REPORT DESIGN ............................... 133
IN THIS LABORATORY YOU WILL: .......................................................... 134
PREPARATIONS ..................................................................................... 135
BUILDING A CUSTOMIZED REPORT .................................................. 136
ADDING A GENERAL SECTION .......................................................... 137
INSERTING TABLES .............................................................................. 138
ADDING A CALIBRATION CURVE ........................................................ 139
FINISHING UP ...................................................................................... 140

LAB EXERCISE: COMMANDS ............................................................... 141
IN THIS LABORATORY YOU WILL: .......................................................... 142
RETRIEVING INFORMATION ABOUT COMMANDS ............................... 143
TRACKING ERRORS AND USING SOME COMMON COMMANDS .......... 144
REGISTERS, OBJECTS, AND TABLES .................................................. 145

LAB EXERCISE: MACRO WRITING ....................................................... 153
IN THIS LABORATORY YOU WILL: .......................................................... 154
WRITING AND EXECUTING A MACRO ............................................. 155
WRITE YOUR OWN MACRO ............................................................... 157
POSSIBLE ANSWER ............................................................................. 158

APPENDIX: GETTING STARTED WITH NEW CHEMSTATION WORKFLOW G2170-90041 ......................................................... 159
Lab Exercise: Introduction to the HPLC ChemStation
Lab Exercise: Introduction to the HPLC ChemStation

In this Laboratory You Will:

- Access the HPLC ChemStation software and understand the purpose of each View.
- Use the ChemStation Configuration Editor.
- Learn about the Scheduler.
- Learn how to maintain the HPLC ChemStation computer.
- Become familiar with some Windows features (optional).
Accessing the HPLC ChemStation

1) Find the **Start** button in the bottom left hand corner of your screen. Click on the **Start** button. Select the menu choice **All Programs**. You will find a list of the software programs installed on this computer arranged in alphabetical order. To launch the ChemStation for LC 3D Systems, find and select the **Agilent ChemStation** menu item.

2) The following items are available: Add Licenses, Configuration Editor, Installation Qualification, Instrument 1 Online, Instrument 1 Offline, readme.txt, and the Scheduler.

3) Click on **Instrument 1 Offline**. The software program will begin loading.

**Question:**
What is the difference between the ChemStation's Online and Offline sessions?

<table>
<thead>
<tr>
<th>View</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4) Open the **View** menu and select **Full Menu**, if this item is available.

5) Access the **View** menu and examine the entries. Notice that there are several main views starting with **Method and Run Control**. List the views below and after exploring each view, list the primary function of each.
Lab Exercise: Introduction to the HPLC ChemStation
Accessing the HPLC ChemStation

6) You can also change views by utilizing the Navigation Buttons.

   Switch Views Here                      Minimize, Maximize
                                           Close

7) Click on the small triangle at the top of the ChemStation Explorer. Click again. Notice that you can sort your files.

8) Click on the **Configure buttons** icon at the bottom of the Navigation Pane – you can use this to add or remove buttons.

9) Find the Minimize, Maximize and Close buttons located in the upper right hand corner of the Title Bar. Minimize the ChemStation software. Notice that the ChemStation software now appears as a button to the right of the Windows **Start** button in the Task Bar. The ChemStation software is still running, but has been cleared from the Desktop.

10) Click on the Instrument 1 (offline) software button in the Task Bar to restore the ChemStation window.

11) To close the ChemStation operating software you may either utilize the Close button located in the upper right hand corner of the window; or, under **File** select **Exit**. Close the ChemStation software now.

NOTE: You will access the Configuration Editor next. In order for the Configuration Editor to open, the HPLC ChemStation software must be closed.
**Configuration Editor**

You customer engineer configured your instrument during installation. This process includes configuring the instrument devices and setting the LAN IP address so that the software can communicate with the instrument. After installation, you may need to access the Configuration Editor to add another instrument, change the default path for methods, sequences or data files, or change the colors used for chromatograms, titles, and baselines.

1) Open the Configura**

   **tion Editor** from Start, All Programs, Agilent ChemStation, then Configuration Editor.

2) Find the small window that contains your instrument configuration and click on the title bar to activate the window.

3) Select Instruments... from the Configure menu. You should have a Modular 3D System configured. Change the Instrument Name from Instrument 1 to a name of your choice. The instrument name is printed in the footer of all reports, and you will use this name to identify reports you print in this course. You should have a

4) OK this dialog box and view the next dialog box showing the instrument type and address. Do not make any changes here. OK this window as well.

5) Now select Configure > Colors.

6) Note the color changes that can be made and practice changing the signal colors. When you are satisfied, set the elements back to their default values and OK the dialog box.

7) Explore other areas of the Configure menu, but do not make any additional changes.

8) Under File, Save the configuration so the new instrument name will be saved. Exit the Configuration Editor (File, Exit).
Scheduler

The Scheduler may be used to make your ChemStation automatically execute commands on a one time, daily, daily weekday, or weekly basis. You may schedule events such as controlling a valve, loading a method or sequence, starting a sequence, or initiating a blank run. As a command is processed, the Scheduler records the completion status as accepted, rejected, not allowed, or instrument not found in the Results column so that the progress can be reviewed easily. Note that the events associated with running an analysis or sequence take precedence over the execution of scheduler events.

1) From the Windows Start button find All Programs, Agilent ChemStation, then Instrument 1 Offline. The ChemStation application must be open for the Scheduler to work. Now select the Scheduler from Start, All Programs, Agilent ChemStation.

2) Using the drop box in the upper left hand corner of the Scheduler, select the instrument to be scheduled.

3) A blank schedule for that instrument will appear. The entries include:

   Date: Enter the first date this command should be sent, current date to one year in advance.

   Time: Using the 24-hour clock format (13:00 is 1:00 PM), enter the Time this command should be sent.

   Command: Enter the command you want to be sent. Command help is found in the ChemStation under the Help menu.

   Mode: Select what day(s) this command should be sent.

   Result: Lists completion status of each command sent to an instrument.

4) For practice, you will make the ChemStation logbook appear on the screen using the Scheduler. Enter the current date. Enter a time approximately 2 minutes from the current clock time (found in the lower right hand corner of the screen). Type: Logbook On in the Command box. The mode will be Do Once.

5) The selected commands will be stored for use once they are saved. Select the Save tool from the toolbar.

6) Minimize the Scheduler and wait to see if the logbook appears automatically.
7) After you have witnessed the logbook display, return to the Scheduler to check the **Result** column.

8) Close the Scheduler.

Note: The Scheduler can be useful for turning on the detector lamp prior to your arrival each day to warm-up. The command is “Lampall On”. Do not include the parentheses.
Maintaining the Windows 2000 Workstation

(Skip to Maintaining the Windows XP Workstation if you have Windows XP)

Cleaning up Temporary Files

After the ChemStation has been used for some time, temporary files may accumulate in the directory specified by the TEMP Variable. These files are generally left open when Windows is abnormally terminated. The files generated have a .tmp extension. These files should be deleted to maintain computer efficiency.

1) Close all programs.
2) Go to the Start button then Search and select For Files or Folders….
3) In the Search for Files or Folders named: field, type *.tmp.
4) In the Look in: field, find your hard drive, C: or Local hard drives.
5) Select Search Now.
6) After a few moments, the files will be displayed. Highlight the first file. Using the Shift key and the left mouse button, highlight the last file. Press the Del key to remove the files. Remember that you will have to empty them from the Recycle bin as well.

Repairing the Disk

Windows 2000 includes a utility to check disk integrity. Among the errors that may be fixed are lost clusters and cross-linked files. Error-checking can move your data from bad sectors as well. You must be logged on as part of the administrator's group to run this utility.

1) Log on as the administrator. Press CTRL-ALT-DEL simultaneously. Log on as the administrator. The password is agilent. Or check with your instructor for the correct password.
2) Double click on the My Computer icon and right-click on the drive icon for C:. Select Properties to display a selection box.
3) Click on the **Tools** tab. Find the **Error-Checking** tool and click **Check Now**.

4) Select to **Automatically fix file system errors** and **Scan for and attempt recovery of bad sectors**.

5) This process can take several minutes. If you don’t wish to do this in lab, **Cancel**, otherwise select **Start**.

**Disk Defragmentation**

A defragmentation utility is included with Windows 2000. Several vendors sell this utility as well such as DiskKeeper. Make certain you defragment your disk drives on a periodic basis. You must close all programs before beginning. The process can take a long time. We will not do this here.

**Creating an Emergency Repair Disk**

You should create an emergency repair disk as soon as possible. Use this disk if your system files are damaged or your computer won't start. The disk includes system settings such as registry files, disk partitions, and installed devices. Make a new repair disk every time you make changes to your hardware or software. Emergency Repair Disks are specific for each computer.

1) From the **Start** button, select **Programs, Accessories, System Tools**, then **Backup**.

2) Click on the **Emergency Repair Disk** button.

3) Insert a floppy into drive A:.

4) Select to also back up the registry to the repair directory.

5) **OK** any dialog boxes that appear then close the Backup program.
Maintaining the Windows XP Workstation

(Skip this section if you completed Maintaining the Windows 2000 Workstation)

Cleaning up Temporary Files

After the ChemStation has been used for some time, temporary files may accumulate in the directory specified by the TEMP Variable. These files are generally left open when Windows is abnormally terminated. The files generated have a .tmp extension. These files should be deleted to maintain computer efficiency.

1) Close all programs.
2) Go to the Start button then select Search. On the right select All files and folders.
3) In the All or part of the file name: field, type *.tmp.
4) In the Look in: field, find your hard drive, C: or Local hard drives.
5) Select Search.
6) After a few moments, the files will be displayed. Highlight the first file. Using the Shift key and the left mouse button, highlight the last file. Press the Del key to remove the files. Remember that you will have to empty them from the Recycle bin as well.

Repairing the Disk

Windows XP includes a utility to check disk integrity. Among the errors that may be fixed are lost clusters and cross-linked files. Error-checking can move your data from bad sectors as well. You must be logged on as part of the administrator's group to run this utility.

1) Log on as the administrator. The password is 3000hanover or, check with your instructor for the correct password.
2) Double click on the My Computer icon and right-click on the drive icon for C:. Select Properties to display a selection box.
3) Click on the **Tools** tab. Find the **Error-Checking** tool and click **Check Now**.

4) Select to **Automatically fix file system errors** and **Scan for and attempt recovery of bad sectors**.

5) This process can take several minutes. If you don’t wish to do this in lab, **Cancel**, otherwise select **Start**.

**Disk Defragmentation**

A defragmentation utility is included with Windows XP. Several vendors sell this utility as well such as DiskKeeper. Make certain you defragment your disk drives on a periodic basis. You must close all programs before beginning. The process can take a long time. We will not do this here.

**Creating an Emergency Repair Disk**

You should create an emergency repair disk as soon as possible. Use this disk if your system files are damaged or your computer won't start. The disk includes system settings such as registry files, disk partitions, and installed devices. Make a new repair disk every time you make changes to your hardware or software. Emergency Repair Disks are specific for each computer. The backup process for Windows XP goes farther than Windows 2000. It consists of two of two parts: a backup file, and a Recovery Disk. The backup file will be large (we cannot do this here), and the Recovery Disk will be a floppy.

1) From the **Start** button, select **All Programs, Accessories, System Tools**, then **Backup**.

2) The Backup Utility Wizard should start by default unless it is disabled. If the Wizard has been disabled, select **Tools** then **Switch to Wizard Mode**.

3) Click the **Advanced Mode** button found in the text.

4) Click the **Automated System Recovery Wizard** button.

5) Click **Next>**. The Wizard will start and prompt you for the media to use for the backup file. As we don’t have the proper media here, cancel out.

You can write this file to a tape drive, a hard disk or writeable CD or DVD. After entering the destination for the backup file, click **Next>** again, and finally, **Finish**. The Windows XP Backup utility will copy all important system files and settings to the backup file. An estimate and status bar are provided. After this step is
Lab Exercise: Introduction to the HPLC ChemStation
Maintaining the Windows XP Workstation

complete, you will be prompted for a blank, formatted floppy disk. Several files are written to the disk to complete the process.
Windows Features (Windows 2000 or XP)

Optional Section

Mastering WINDOWS could take a week long class in itself. This section of the laboratory is simply a brief familiarization of some of the important aspects frequently utilized in conjunction with ChemStations. *If you are already familiar with Windows, skip this section.*

Windows Explorer

The Windows Explorer is a powerful file manager. All files are stored in folders (directories) on your hard disk. The Explorer allows you to copy, move, and print entire folders and individual files.

1) To open the Windows Explorer, click on the **Start** button and select **All Programs**, **Accessories**, **Windows Explorer**. The program will load.

2) Take a look at the information displayed on the left. These are all the objects found in your computer. If the object has a + sign next to the name, the folder contains sub-items such as sub-folders (subdirectories) or files that are not currently shown. Click on the + signs until you can open **Chem32** (C:\Chem32). This opens the sublevels.

3) Click on the + sign next to the 1 folder. The data folder should now be present. Similarly, open the **Data** and **Demo** folders. Click on the Demo item itself not the + sign. Notice that the contents of the folder appear in the right pane as a group of folders. The individual files in the Demo folder (directory) are displayed after the sub-folders.

4) To copy files from the data folder to a floppy drive, simply click on the folder or file which needs to be moved and drag it to the **3 1/2 Floppy (A:)** item in the left pane. Try this now with one of the displayed data files. Make sure that you have a formatted disk in the drive.

**NOTE:** When you drag files between different drives they are copied, not moved. An original copy remains on the source drive. When you drag files between folders on the same drive, Windows assumes you want to move the files, not copy them.

**NOTE:** To select multiple files, click on the first file to select it. **Ctrl-Click** on any additional files. To select a group of consecutive files, click on the first file to select it. Then, use a **Shift-Click** on the last item to be selected.
5) Check to make certain that you have copied the chosen file into drive A: by expanding the 3 1/2 Floppy (A:) item.

6) To delete a file or folder (when you delete a folder, all the contents of the folder will be deleted along with the folder itself) right click on the folder or file in the left or right pane. From the **File** menu select **Delete**. Try this now with one of the data files in the Data\Demo folder.

7) The contents of the file will be moved to the Recycle Bin. The Recycle Bin is found as an icon on the Windows desktop. Open this now. This is a special folder on your disk. The Recycle Bin holds your deleted files until you empty the bin, just in case you made a mistake. To restore a file from the Recycle Bin, click on the item or items you accidentally deleted. From the **File** menu select **Restore**. Once the bin has been emptied however, the only way to retrieve a file is with a special undelete program. Try to restore the file you deleted in part 6.

**NOTE:** Remember you must empty the Recycle Bin to gain space on your hard drive. The **Empty Recycle Bin** option is found under the **File** menu in the Recycle Bin.

8) You may open any file in the Windows Explorer to display its contents. Simply double click on the item in the right pane. Practice your skills. From the **File** menu, **Close** the Windows Explorer.

**Wallpaper and Screen Savers**

The Wallpaper simply lets you decorate the background of your Desktop.

1) Right click on any empty area of the Desktop. Select **Properties**.
2) Click on the **Desktop** tab of the **Display Properties** box.
3) Scroll through the **Background** list and highlight the one you would like. **OK** the panel.
4) A screen saver will prevent a static image from burning into your screen.
5) Right click on any empty area of the Desktop. Select **Properties**.
6) Click on the **Screen Saver** tab.
7) Select a file from the Drop box. Make any other changes you desire.
8) **OK** the panel when you have made your selections.
Clipboard

You may use the clipboard to capture the entire screen, an entire window or any selected material within a document or graphic using the cut or copy commands found in Windows based programs. The image is temporarily stored until you paste it into the same or another application. For instance, say that you were creating a written HPLC method. You can copy the Pump Settings window from the HPLC ChemStation software then paste it into a word processing program such as Microsoft Word or WordPad.

1) Open the Instrument 1 Offline session.
2) Go to the Method and RunControl view. Under the Instrument menu, select Set up Pump....
3) Press the ALT and PrintScreen keys simultaneously to copy the window to the clipboard. Cancel the Set up Pump dialog box.
4) Minimize the HPLC ChemStation.
5) From the Start button, go to Programs, Accessories. Select WordPad.
6) Click on the spot in the window where you would like to place the Pump Parameter window.
7) From the Edit menu, select Paste.

The graphic is now part of the WordPad document.

Closing a Program that is Not Operational

Occasionally, you may find that the ChemStation or another Windows program stops functioning or becomes "hung-up". You may try to cancel the hung-up program rather than rebooting the entire computer. To do this, strike CTRL, ALT and DEL simultaneously and abort the offending program.

2) Select the program marked for termination. Here, select WordPad, then select End Task. Note that WordPad is closed, while other software remains open.
If these actions do not clear your problem, you would have to reboot the computer.
Lab Exercise: Acquisition Methods
In this Laboratory You Will:

- Prepare your instrument for acquisition.
- Set-up an acquisition method.
- Run an acquisition method.
- Take a snapshot of the data.
Preparation

Before starting, make certain that you have the following:

- A sample vial labeled, sample, which contains the Test Mix, Part # 01080-68704 (diluted).

- HPLC grade water in channel A and HPLC grade acetonitrile in channel B.

- A 4.0 x 100 mm, C-18 column installed in the column compartment.

- An Agilent 1100/1200 with all modules powered on.

- An HPLC ChemStation, B.03.xx, equipped with a spectral module.
Preparing the HPLC

1) Enter the **Method and Run Control** view of the Agilent Online ChemStation.

2) From the **View** menu, select **Instrument Actuals, the System Diagram and Sampling Diagram**. If a check mark exists beside the item, it is already on.

3) Load the default method, `DEF_LC.M` as a starting point for method creation (**Method, New Method**) or double-click on `DEF_LC.M` in the ChemStation Explorer.

4) Under the **Instrument** menu, select **More DAD, Control**. Turn on the UV and Vis lamps. **OK** the window. Remember that you may also turn the lamp on from the system diagram GUI.
Priming the Agilent 1100/1200 Solvent Delivery System

You should prime the pump when you change mobile phases, when the instrument has been sitting without flow for long periods of time, when you have performed maintenance on the HPLC, or when you experience periodic perturbations in the baseline.

1) If you are equipped with a vacuum degasser, make certain the degasser is on.

2) Ensure that the outlet tube is connected from the purge valve to the waste container. Open the purge valve located on the pump module by turning the knob counterclockwise several turns.

3) To prime the solvent delivery system, you should pump 100% at 5 mL/min from each channel for several minutes. To accomplish this task, select the following menu items: Instrument, Set up Pump...; or click on the pump in the system diagram (shown below), then Set up Pump....

4) Type in a Flow of 5.000 mL/min and %A of 100. OK the window.

5) To turn the solvent delivery system on, you may use the menu items: Instrument, More Pump, Control; or, access the tool shown in the diagram below. Do this now.
6) Wait until a steady stream of solvent comes out of the purge valve waste tube.

7) Repeat steps 3 through 6 for the other channels of the pump. Change to the composition for your next run, %B=70.

8) Turn off the pump.

9) Close the purge valve. Set the required composition and flow rate for your next application. In this case: Flow 1.5 mL/min and %B 70.

10) Turn on the pump and allow the column to equilibrate.

Note: Always keep HPLC grade solvent in all pump channels to prevent valve damage even when the channel is not being used. For a reversed phase system, place water with 20% methanol in the unused channels.
Creating an Acquisition Method

1) From the Method menu select Edit Entire Method... or select the Edit entire Method tool.

2) Select only the Method Information and Instrument/Acquisition sections for editing. OK this window.

3) The Method Information dialog box now appears. You may enter any information here that pertains to the method. Enter a description now. OK the window.

4) Fill in the following solvent delivery system parameters:

![Image of solvent delivery system parameters]

**Question:**
What is the function of the Min: Pressure Limit?
Practice Entering Gradients

1) Select the **Insert** button from the Time Table group. Program a linear gradient to 100%B over 4.0 minutes. In the **Time** column, type 4. In the **%B** column type 100.

2) Go to the Display dropdown. Select **Solvents**.

3) Return to the **Timetable** display. Click on the 1 next to the timetable line, then cut. Unfortunately, you do not need a gradient for this analysis, **OK** the Pump Parameters window.

Back to the Acquisition Method

1) Select a Standard Injection with a 5 µl injection volume. Select **More...** to view all injection options.

**Question:**
What is the slowest draw speed? (hint: type in 1µl)

__________________________________________________________________________

When would you reduce the draw speed?

__________________________________________________________________________

2) **OK** the window.

3) Fill in the DAD Signals as below. **OK** the window.

Note: If a VWD detector is being utilized, select the same wavelength as signal A.
**Question:**

How is the threshold setting used?

---

4) Set the column compartment temperature to 40°C. Make certain that the right compartment has the same temperature as the left compartment. OK the window.

5) From the Method menu, select Save Method As.... Name the method, Class.m. The ChemStation will not let you overwrite DEF_LC.M; that way, it will always be there as a template for new methods. This master acquisition method is now prepared. Note that this method is saved in the directory: C:\Chem32\\Methods.

6) Add a comment to the method history. You can view the method history by selecting Method, then Method Change History.... Close the window.

7) Go to the View menu and select Online Signals, Signal Window 1. Once the Online Plot is displayed, select Change.
Lab Exercise: Acquisition Methods  
Practice Entering Gradients

8) Add DAD A to Selected Signals. Fill in an x-axis range of 10 minutes. Select the draw zero line box.

9) Click on the DAD A Signal in the Selected Signals box then set the y-axis range to 100 mAU and the offset to 10%. OK the dialog box.

10) From the Method menu, select the Run Time Checklist. Select Data Acquisition only. Save a copy of the Method with the data. OK the dialog box. A report will not automatically print with this method.

11) Resave the Method.

12) Once you have a steady baseline and pressure, pull down the RunControl menu and select Sample Info... The panel can be accessed by the tool shown below. (hint: to stabilize the baseline use the Detector Balance Button)

13) Fill in the Operator Name, Filename (Class.d), the subdirectory (your name), Location (Vial 1), sample name (test sample) and Comment information.

Question:
What is the Sample Amount used for? Look in the Help screen for clues.

14) Start the run either from the Start tool or from the RunControl menu, then Run Method.
Snapshot

1) Once the first major peak has eluted, open an Offline Session of the Agilent ChemStation.

2) Go to the Data Analysis view of the Offline Session.

3) Go to the File menu and select, Snapshot. The current chromatogram appears in the chromatogram window of the Offline Session.

4) Click on the Data button in the ChemStation Explorer and find your subdirectory.

5) Double-click on the Single Runs and find the SNAPSHOT.D in the navigation table.

6) Return to the Online Session.

7) When the run is complete, turn the System Off. This control is found under the Instrument menu.

You are finished with this laboratory.
Lab Exercise: Qualitative Data Analysis

Ideally, use the data file generated from the isocratic test mix in the previous laboratory exercise. If this is not available, use demo\005-0104.d and demo\demodad.d.
Lab Exercise: Qualitative Data Analysis

In this Laboratory You Will:

1) Use signal options to display data.
2) Annotate chromatograms.
3) Use the Window Functions.
4) Use the peak purity algorithm to examine the purity of chromatographic peaks.
5) Overlay and view UV spectra.
6) Use Isoabsorbance and 3D plotting.
Lab Exercise: Qualitative Data Analysis

Graphics - Signal Options

1) Enter the Data Analysis view.

2) Load the method democal2.m. Either double-click on democal2.m in the method ChemStation Explorer or select Method > Load Method.

3) In Data Analysis, just below the Navigation Table on the left, there are five tools for five types of data analysis tasks: Integration, Calibration, Signal, Purify and Spectrum.

![Toolbars for Data Analysis Tasks](image)

The choice of data analysis task causes the tool bars to display appropriate tools for the type of task. For this exercise, select the Signal Tool. The chromatogram will then be displayed as large as possible, and the tool bars will show the Signal Manipulation Tools.

4) In the Graphics menu, select Signal Options....

5) Use the Signal Options dialog box to define how chromatographic signals will look when drawn to the screen or printer. For this example, select to include: Axes, Baselines, Tic Marks, and Retention Times. Note that the fonts are selectable. This example chromatogram will use the entire recorded x and y axes, Full Ranges. For the Multi-Chromatogram output, select Layout: Overlaid with the Scale: All the same Scale. OK this dialog box.

6) Expand the Demo files in the Data ChemStation Explorer. Find the Single Runs and double-click to load them into the Navigation Table.

7) Go to the Navigation Table. Position the mouse on the Method Name heading. Click the right mouse button. Choose Group By This Column. What happens?

8) Click on the ‘+’ on several of the methods listed to see the new layout of the table. Right click anywhere in the heading row and choose Reset grouping. What happens? Notice that you can customize the layout of the Navigation table using the tools provided.

9) Find the data file C:\Chem32\data\demo\005-0104.d in the Navigation Table (Demo – Single Runs) or find the file you acquired in the acquisition lab. Double-click to load into the Navigation Table.

10) In the Navigation Table, click on the ‘+’ in the first column next to the date/time stamp.
11) A panel with 3 tabs will appear. The Signals tab should be highlighted and all signals will be initially selected. Click off one of the signals.

12) Select the Inst. Curves tab. Click to make sure there is a check in the High Pressure checkbox. Click the General Info tab to see what information is available.

13) Click the right mouse button in the row containing the datafile. Choose Load Selected Signals. The overlaid chromatograms and high-pressure plot will appear.

14) An additional tool bar, the Graphics Tool Bar, can be displayed along the right side of the chromatogram. This tool bar is turned on or off by clicking on the Graphics Tool. Do this now.

15) Now try to plot the signals separated, each in full scale. This time, you can use the Overlay Separate Signals tool and the Each in Same Scale Tool.

You may need to scroll down to view all signals and the pressure plot.

16) Practice using the other tools in the Graphics Tool bar. You can see what the names of the various tools are by positioning the cursor over that tool and looking at the information line at the bottom of the Data Analysis Screen.
Graphics - Annotation

1) Using the Signal(s) Displayed drop box, select DAD1A only.

2) Select the Graphics too.

3) From the Graphics menu, select New Annotation or select the Add Annotation tool.

Position the cursor in the center-top of the chromatogram and click the left mouse button.

4) When the Text Annotation box appears, type in Test Mix. Select Options. You may select a font and font size. OK the options and then OK the annotation box.

5) Click above the third major peak in the chromatogram with the left mouse button. When the Text Annotation box appears, type in Target Compound. Under Options, change the text rotation to 90. OK the options and annotation box.

6) From the Graphics menu, select Line Annotation or use the Draw Line in Window Tool. Using the cursor, draw a line from the Target Compound annotation to the chromatographic peak.
Lab Exercise: Qualitative Data Analysis

Graphics - Annotation

7) To print this window, pull down the File menu and select Print, Selected Window. Now Print the annotated chromatogram.

8) Practice with the Delete Annotation and Move Annotation menu items found under the Graphics menu or use the corresponding tools.

9) When finished with these tools, you can turn off the Graphics Tool bar by clicking the graphics tool again.
Window Functions

1) Use the Signal(s) Displayed drop box to view All Loaded Signals.
2) From the View menu, select Window Functions, List Content.
3) Position the cursor in the margin left of the Pump1, Pressure entry. Click using the left mouse button. This line should now be highlighted.
4) Press the Delete Obj. button.
5) What happened to the pressure display?

6) Highlight one of the signals. Using the left mouse button, click on List Data. The chromatographic data points are displayed. Close the windows created in this exercise.
Lab Exercise: Qualitative Data Analysis
Peak Purity

Peak Purity

The Peak Purity algorithm can help you determine whether a chromatographic peak is comprised of one or more components. In quality control, impurities hidden behind the peak of interest can falsify results. In research, a hidden component left undetected might lead to a loss of essential information.

1) In the Methods ChemStation Explorer, find DEF_LC.M and load the method by double-clicking on the name.

2) In the Data ChemStation Explorer, double-click on the Single Runs found under the Demo folder to load the files into the Navigation Table.

3) Load one signal from DEMODAD.D. Now go to the Spectra menu and choose Select Peak Purity. In this exercise, you will use the default purity options. Alternatively, use the tools.

4) Click on a major chromatographic peak. Examine the resulting displays. Compare your results to that of the pure and impure peaks presented in the lecture. Make sure you compare the Purity Factor and the calculated Threshold found by selecting the Information on the LC Peak Purity Tool.

5) Select three major peaks and answer the questions below. To review another chromatographic peak, simply click on the peak in the chromatogram located in the upper portion of the purity display.
**Major Peaks**

<table>
<thead>
<tr>
<th></th>
<th>Peak 1</th>
<th>Peak 2</th>
<th>Peak 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Retention Time</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Calculated Threshold</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Purity Factor</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Spectral Options – Wavelength Range</em></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Spectral Options – Spectra per Peak: Threshold</em></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Does the ChemStation indicate purity or impurity?

In your opinion, does the spectral overlay indicate impurity?

In your opinion, does the relationship between the similarity and threshold curves indicate impurity?

Do the number of diamonds in the red band indicate impurity?

Does the relationship between the purity factor and calculated threshold indicate impurity?

Do you think this peak is impure?

---

6) Close the purity display with the tool found at the lower right.
Automated Peak Purity

The Short + Spectrum, Detail + Spectrum, and Full report styles will produce automated peak purity analyses of integrated chromatographic peaks.

1) Make certain that you are in the Data Analysis view and demo\demodad.d is loaded. Load the method, purity.m.

2) To print an automated peak purity report, open the Report menu and select Specify Report.

3) Change the Report style to Short + Spectrum. You may send this report to the Screen only to save time. OK the dialog box.

4) Under the Report menu, select Print Report. Examine the resulting report and Close if you sent it to the screen.

Note: Purity Options may be saved as part of the method in order to produce the desired peak purity report.
Displaying Spectra

1) With demo\demodad.d still loaded, use the signals drop box to select only one signal for the window. If necessary, enlarge the chromatogram window by grabbing the bottom of the window and dragging to view the peaks more easily.

2) Under the Spectra menu, select Spectra Options or select the Spectral Task tool, then the Edit Spectra Display and Processing Options tool.

3) Select the type of background subtraction best suited for this analysis in the Reference tab. Try Automatic or select your own spectra. OK this dialog box.

4) Go to the Spectra menu and choose Select Spectrum or click on the Select Spectrum tool.

5) Position the mouse pointer on a peak of interest at the upslope of the chromatographic peak and click the left mouse button. The upslope is half way up the left side. Notice that the Reference Spectra and the Original Spectrum are displayed in one window (on the right). The subtracted spectrum is displayed in the other window (on the left).

6) Now overlay the background subtracted downslope spectrum. The downslope spectrum is on the right-hand side of the peak. To do this hold the CTRL key down while clicking the left mouse button.

   What information can you obtain by comparing the upslope and downslope spectra?

7) From the Spectra menu, choose any of the other select spectra items and practice with them. Practice with the tools as well.
Lab Exercise: Qualitative Data Analysis
Isoabsorbance Plot

Isoabsorbance Plot

In this section, you will try to optimize the data acquisition sample signal with the emphasis on obtaining the best signal to noise ratio for one chromatographic peak. Note that to use the Isoabsorbance plot, data must have been acquired with the spectra stored in the All format.

1) Reload Signal B of DEMODAD.D. Use the Select Spectrum at Peak Apex tool to display the spectrum of the peak at 4.85 minutes.

2) Before you make the Isoabsorbance plot, examine the spectrum of the peak of interest. Convert the cursor to Trace Mode by pointing the cursor at the spectrum and clicking the right mouse button. The cursor is converted to a downward pointing arrow that follows the spectrum trace as you move the mouse. If you find the cursor hard to control, you can also use the right and left arrow keys on the keyboard to move the cursor. Notice that the cursor position is identified on the information line at the bottom of the window. This makes it easy to see where the absorbance maximum occurs.

3) Move the cursor along the spectrum and determine the wavelength to use for the sample signal. Make a note of it below. Decide what the sample signal bandwidth should be. Also, select an appropriate reference and reference bandwidth. Remember the selection guidelines discussed in the lecture.

Sample Signal__________
Sample Signal Bandwidth__________
Reference Signal__________
Reference Bandwidth__________

4) Now we are ready to make the Isoabsorbance plot. Under the Spectra menu, select Iso/3D Plot Options…. Set a time range of 4 to 14 minutes and the Traditional color scheme. Select Make Isoplot.

5) Once the isoplot has been drawn, take a minute to familiarize yourself with the display. Check that the Cursor mode is Quick View. Point the cursor at the vertical cursor and move it right and left to select various spectra. The spectra at the position of the cursor are shown in the window at the top right. The blue spectrum that appears in this window is the spectrum you previously
selected in Data Analysis, that of the peak at 4.85 minutes. Convince yourself that this is the case by moving the vertical cursor to a time of 4.85 minutes.

6) Now point the cursor at the horizontal line across your Isoabsorbance plot. As you move this cursor up and down, watch the chromatogram in the lower section of the screen. The black chromatogram changes as you change the sample signal wavelength.

7) Change the cursor mode to **Signal**. To extract a signal corresponding to the sample and reference wavelengths you determined earlier, you can simply type the values you want in the box at the upper left. To access the reference signal click in the check box next to **Ref**.

8) You can also select the sample and reference signals graphically. Press and hold the CNTRL key while you move the sample signal band or the reference signal band. You can keep the same bandwidth, but just adjust the position of the band, by releasing the CNTRL key and then moving the signal band.

*Note:* If you want to start over, just exit the Isoabsorbance plot and redraw it by selecting the Spectra menu, then Isoabsorbance plot. Don’t forget to change the cursor mode to **Signal**.

9) When you are satisfied with your extracted signal, select the **Copy** button at the lower left corner of the Isoabsorbance plot. Minimize the isoplot window and view the extracted signal. Overlay the extracted signal with signal B. You will have to select All Loaded Signals with the drop box.

Did you improve the signal to noise ratio of the peak?

10) You may continue to try other sample signals, bandwidths and references. When you have finished, record the optimized values here.

   Sample Signal

   Sample Signal Bandwidth

   Reference Signal

   Reference Bandwidth

11) **Close** the IsoPlot.

If you have time, optimize the Diode Array signals for the 3rd and last major peak in the acquisition data file. Record the results here and use in the next laboratories.

   Sample Signal

   Sample Signal Bandwidth

   Reference Signal

   Reference Bandwidth
3D Plot

1) From the Spectra menu, select 3D Plot. Maximize the window.

2) Rotate the 3D plot. Notice that you can use the cursor on the wavelength axis to change the wavelength and view the resulting chromatogram. Use the cursor on the time axis to show a spectrum at different times.

3) Use the Data View button at the lower left to change the time range or wavelength range.

4) Explore the other options.

5) Close the 3D plot.
Lab Exercise: Spectral Libraries
In this Laboratory You Will:

- Build a spectral library.
- Perform a library search.

You will need Class.M and Class.D created in the acquisition laboratory. If you don’t have either of these files, use Isocra.m and one of the demo sequence files that was created with this method.
Building a Library

1) From the View menu, select Data Analysis.

2) Load Class.D created in the acquisition exercise. (File, Load Signal). Load the acquisition method as well, Class.M.

3) Your first task will be to create a library file. Under the Spectra menu, select Library, then New Library. A new panel appears. Give the library a unique name or call it Class.UVL. OK this window.

4) The Edit Library Header box appears. In the Info box, fill in the information about the analysis conditions including column, flow rate, composition, and instrumentation.

5) Click on Library name and type in Class Library.

6) Under Created by, type in your name. OK the Library Header.

7) Now you will put spectra into the library. First, set up automated background subtraction to improve spectral quality. Under the Spectra menu, choose Spectra Options or select the Edit Spectra Display and Processing Options tool.

8) Find the Reference tab. Select Automatic. OK the window.

9) Pull down the Spectra menu and choose Select Peak Apex Spectrum or click on the Select spectrum at peak apex position tool.

Obtain the spectrum of the last major peak by clicking on it. Holding down the Ctrl key, select the apex spectrum for each of the three other major chromatographic peaks in the chromatogram. Make certain that the order is from the last peak to the first peak.

10) Go to the Spectra menu and select Library then Add Entries or use the Add Spectra Entries to Current Library tool.
11) Click on Name and type in Dimethylphthalate. (Do not press Enter, as doing so will complete the entry.)

12) Other fields are present that you can use to customize your entries. Find the Sample entry and fill in Test Mix.

13) Scroll down until you find Slit Width. This parameter may be found on the Set up DAD Signals screen under the Instrument menu in the Method and Run Control view. Fill in the applicable width: 1, 2, 4, 8, or 16 nm.

14) Explore the Edit Wavetable. Select Autom. Note that it labels lambda max. This data is useful for spectral comparisons.

15) OK the Edit Wavetable dialog box and then Add the spectrum to the library. The next spectrum you chose now appears.

16) Fill in the name of the compound, Diethylphthalate. Fill in the remaining information requested. Select Add to add the spectrum to the library.

17) Now add the information for spectra for peaks 3 and 4 to the library. Peak 3 is Biphenyl and peak 4 is o-terphenyl. You now have a library with 4 spectra. OK the Add Entries dialog box.

18) View your library entries by pulling down the Spectra, Library, Manage Entries... menu selections or click on the Change Spectra Entries of the Current Library tool.

19) Select Biphenyl, then Show Spectra. The spectrum is displayed. OK this dialog box. Note that you can delete or edit entries. You may also copy the spectrum to the spectral window of Data Analysis (Copy Spectra). When you have finished exploring, OK the Spectra Library Manager panel.

20) Save the library with the Save Current Library File tool or through the menus: Spectra, Library, Save Library.
Library Searching

In this section you will test your library with the same data file. Later we will use the library with new files in an automated fashion. Check that the library file you want to search from is currently loaded (look in the Library tool bar).

Normally, if you were going to perform a library search, you would have to open the library first. **Open Library** is found under the **Spectra, Library** menus. You could also use the **Load a Library File** tool.

1) From the **Spectra** menu, select **Library, Edit Search Template**. You will perform the search within a retention time window. Select **Left Window (%)** and type in 5. Give the **Right Window (%)** a value of 5 as well. You have now defined a time range in the library within which spectra are searched, + or - 5% of the retention time of the unknown.

2) Give the **threshold** a value of **2 mAU**. Low absorbing portions of the spectra will be removed and not used in the match calculation improving the reliability of the match.

3) You do not need to put in a **shift**. This might be useful if your data and the library data were acquired on different instruments. **OK** the template.

4) Under the **Spectra** menu, choose **Select Peak Apex Spectrum** or use the Peak apex spectrum tool. Select the apex spectrum from the first chromatographic peak. Under the **Spectra** menu, select **Library, Search Spectrum** or use the **Search the Spectrum in Current Library** tool.

5) The Library Search Results are displayed in the lower right hand side of the screen. Note that the best match is Dimethylphthalate. If other matches are listed, they were found within the specified retention time window. Did you get a perfect match of 1000?

6) Examine the **Spectral Difference** window. Because you have a perfect match, the difference should be zero.

7) Notice also that you have the unknown (target) and the library spectrum displayed in the window on the left.

8) Perform library searches on the other peaks in the chromatogram. Do not delete this library file. You will use it later for automated library searching later.
Lab Exercise: Spectral Libraries

Library Searching
Lab Exercise: Overview and Diagnostics
In this Laboratory You Will:

- Learn to correctly identify the hardware elements and flow path of the 1100/1200 Series Modules.
- Learn how to track errors and use the logbook
- Learn how the ChemStation can help you diagnose problems
- Learn how to set EMF Limits
- Become familiar with the Maintenance and Repair CD-ROM and some maintenance procedures.

Overview of Equipment and Tools Used

- Agilent 1100/1200 Series HPLC, HPLC-grade water in channel A and HPLC grade methanol, acetonitrile, or isopropanol in channel B.
- ChemStation equipped with HPLC ChemStation Software and speakers.

Consumables

- Agilent 1100 Maintenance and Repair CD-ROM (01100-60007)
## The Agilent 1200 Flow Path

Please locate the items listed below with your instructor and fill in the table provided.

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solvent Reservoir</td>
<td></td>
</tr>
<tr>
<td>Solvent Inlet Filter</td>
<td></td>
</tr>
<tr>
<td>Vacuum Degasser</td>
<td></td>
</tr>
<tr>
<td>Multi-channel Gradient Valve (Quaternary only)</td>
<td></td>
</tr>
<tr>
<td>Active Inlet Valve</td>
<td></td>
</tr>
<tr>
<td>Pump Head</td>
<td></td>
</tr>
<tr>
<td>Outlet Ball Valve</td>
<td></td>
</tr>
<tr>
<td>Damper</td>
<td></td>
</tr>
<tr>
<td>Purge Valve</td>
<td></td>
</tr>
<tr>
<td>Mixer (Binary)</td>
<td></td>
</tr>
<tr>
<td>Injection Valve in Autosampler</td>
<td></td>
</tr>
<tr>
<td>Metering Device</td>
<td></td>
</tr>
<tr>
<td>Sample Loop</td>
<td></td>
</tr>
<tr>
<td>Needle Seat</td>
<td></td>
</tr>
<tr>
<td>Needle Seat Capillary</td>
<td></td>
</tr>
<tr>
<td>Column Compartment</td>
<td></td>
</tr>
<tr>
<td>Column ID Tag and Sensor</td>
<td></td>
</tr>
<tr>
<td>Detector Lamps</td>
<td></td>
</tr>
<tr>
<td>Detector Flow Cell</td>
<td></td>
</tr>
</tbody>
</table>
Error Messages and the Logbook

When an error (blockage, component failure, etc.) occurs on one of the Agilent 1200 Series modules, the tool in the Method and Run Control view that represents that component will turn red and the Run Status window will display a Not Ready message. Information about the error may be found in the bubble above the module tool. To obtain more information, open the Logbook. In this exercise, you will simulate a blockage by lowering the maximum pressure limit to demonstrate these features.

1) Enter the Method and Run Control view of the Online session. Select the Instrument menu, then Setup Pump.... Lower the Max Pressure limit to 10 bar. Set the flow rate to 1.00 mL/min. OK the panel.

2) Again, under the Instrument menu, select System On. In a few moments, the instrument will shut down and the error will be displayed. Note the red color and the information presented in the bubble.

3) From the View menu, select Logbook, Current Logbook. Alternatively, you can display the logbook using the Show/Hide Logbook tool on the tool bar. The top entry in the logbook was the last entry, in this case, the error. The information displayed is:

4) To find out more about the error, double click on the logbook entry. The on-line help will appear. Scroll through the error listings until you have found the above error. The on-line help can be a good starting point to diagnose an error. Close the Help and the Logbook.

5) Return the Max Pressure setting to 400 bar so that you may continue.
Diagnosis View

The 1200 Series ChemStation is equipped with a view to help you: 1) diagnose systemic problems such as poor retention time precision, 2) perform diagnostic tests, such as the lamp intensity test, 3) record information pertaining to instrument maintenance; and 4) provide you with a means to determine when instrument maintenance should be performed, Early Maintenance Feedback (EMF). This view is called Diagnosis. In this section, you will explore the software to become acquainted with its layout and function. In later sections, you will perform diagnostic tests and maintenance from this section of the software.

Early Maintenance Feedback (EMF)

The Early Maintenance Feedback system allows the user to schedule preventive maintenance based upon instrument usage. For instance, seals may be replaced based upon seal wear and the rotor seal may be replaced based upon the number of valve switches. The analyst inputs usage limits based upon previous maintenance experience. For instance, if the rotor seal previously failed after 20,000 injections, a limit of 18,000 valve switches might be inserted as the EMF valve switch limit. When 18,000 injections have been made, the EMF indicator found in the Method and Run Control or Diagnosis view would change from a green check mark to a yellow question mark indicating that one of the EMF limits had been reached. In this part of the laboratory, you will practice inserting EMF limits and observe the EMF indicator.

1) From the View menu, change to the Diagnosis view. Click on the EMF tool located near the center of the window. The Memo Pad on the right hand side of the window will display the EMF information.

2) Select the pump in the drop-down box. To set a limit, highlight the limit entry box. To test the EMF system, set the seal wear limit 2 units above the actual seal wear. Note: The seal wear counter increases as a function of both flow rate and pressure. If your system does not have a column installed, the pressure will be quite low. In this case you may want to set the flow rate to 2-3 mL/min so that the seal wear counter will change sooner.

3) Return to the Method and Run Control view. Notice that the check mark on the EMF indicator is currently green. Under the Instrument menu, select System On or turn the pump on at the System Diagram. In a few moments, the EMF indicator will change from green to yellow, indicating that one of the set limits has been exceeded (in this case the seal wear limit).
Lab Exercise: Overview and Diagnostics

Diagnosis View

*Note:* Exceeding an EMF limit will not shut down your system or abort any method or sequence. It simply changes the appearance of the EMF indicator.

When the EMF indicator is yellow, the user should go to the Diagnosis view, click on the EMF tool and examine the EMF Memo Pad to find out what preventive maintenance is due by comparing the Limit and the Actual values.

4) Return to the Diagnosis view.

Diagnosis Instrument Panel

In the left center of your Diagnosis view, a schematic of each instrument module is shown. Information such as firmware revisions, the number of cycles a valve has made, and the number of hours the lamp has burned can be accessed from these graphical tools. A logbook, module tests, and module temperature history are also available. In this section, you will explore these options.

1) Click on the pump diagram, and then select Update Variables Display. Note that pump module information such as the Serial Number and Firmware Revision is displayed below the diagram.

2) Click on the pump diagram again. This time, select Show Module Details. A detailed schematic of the pump appears.

3) In a box to the right, you will see a symbol for the Logbook, an open book (representing the method) and a thermometer. Click on the Logbook symbol, then Maintenance Logbook Entry. When you perform routine maintenance, enter the maintenance activity into the Maintenance Logbook. If an instrument counter is associated with a maintenance activity, you will be prompted to reset the counter. Cancel the Maintenance Logbook.

4) Again, click on the Logbook symbol, then Update Variables Display. Below you will find access to the Error Logbook, Runs Logbook,
Maintenance Logbook, and Date Changes Logbook. Examine each one of these entries.

5) Click on the open book tool and examine the menu choices available. Take a look at the Solvent Fillings... option. This panel will help you keep track of the amount of solvent in a reservoir. OK the panel.

6) Now, click on the Thermometer, then Update Variables Display. Now select, Pump Temp History. This plot shows the temperature history of the ambient sensor on the main board over the past 12 hours of operation. The sensor is able to respond to ambient temperature changes. The temperature history data is useful when diagnosing problems related to large external temperature fluctuations.

7) Now drag the mouse over the detailed pump diagram. Notice that the arrow changes to a hand when you cross over some parts of the schematic. Click on one of the items associated with a hand, then select Update Variables Display.

8) Look at the detailed information provided. Select other items on the diagram and view their detailed information.

9) Now, click on the large blue arrow in the detailed instrument diagram box. This arrow will take you back to the Toplevel Instrument Panel.

Diagnosing Systematic Problems

The Diagnosis view contains software to help you find the root cause of either a systematic problem such as poor retention time precision or of an OQ/PV test failure. You will explore this capability now.

1) Find the Observed Symptoms part of the tool bar at the top center of your window. There are two choices available, OQ/PV and Analytic. Click on OQ/PV.

2) NOTE: OQ/PV tests are found in the OQ/PV view. These tests are designed to verify instrument performance.

3) Click on the drop box arrow to access a list of the OQ/PV tests that may have failed.

4) Select Flow Test Failed.

5) Go to the second drop box where you see Air in the System and click on the drop box arrow. You will find a list of possible causes for the Flow Test failure.

6) Select Defective Seal or Piston. Notice that the Memo Pad displays the seal wear as well as a Leak Test. The information presented is relevant to diagnosis of the problem.
Lab Exercise: Overview and Diagnostics

**Diagnosis View**

7) Click on the **Start** button located next to the Leak Test option. The Leak Test is displayed. Click on the **Explain** button to find out more about the test. At this point in your troubleshooting process, you could **Start** the Leak Test, analyze the results, and then perform the required maintenance.

8) **Close** the Leak Test and Leak Test Information. You will get a chance to run an instrument test later.

9) Now, select **Analytic** from the **Observed Symptoms**. Pull down the drop box to find a list of common chromatographic problems. Select one of the problems.

10) Go to the possible causes drop box and pull down a list of causes. Select one of the causes and notice that instrument information is again provided along with helpful tests to confirm the probable cause.

**Instrument Tests**

The **Diagnosis** view contains a complete selection of diagnostic tests such as the Leak Test you encountered previously. The tests are a convenient resource to track instrument performance. For instance, users often want to test the lamp intensity. A test is available for that purpose.

1) Make certain that you are in the **Diagnosis** view. Select the **Diagnosis** menu, then **Tests**…

2) The **Test Selection** panel is displayed. Select the detector in the drop-down box. A list of tests available for the detector is shown.

3) Click on **DAD Intensity Test**. A description of the test is shown at the right and the Start button is found below for beginning the test.

4) Explore the other available tests, but do not run any just now. In other lab exercises you will perform some of the most important tests.

5) **Close** the Test Selection Panel.

**Maintenance and Repair CD-ROM**

When a diagnostic test procedure, Early Maintenance Feedback, or your own experience indicates that maintenance should be performed, two resources can help. First, each of the 1200 instrument modules has a detailed, systematic reference manual. In addition, the Maintenance and Repair CD-ROM (part number 01100-60007) can lead you through each maintenance procedure in a multi-media format. The CD-ROM is easily accessed through the **Diagnosis** view or can be viewed independently of the ChemStation software simply by accessing your CD-ROM drive. In this part of the laboratory, you will learn how to use the
maintenance CD-ROM and then learn to perform user maintenance procedures on the 1200 modules.

1) Insert the HPLC Maintenance and Repair CD into the CD-ROM drive. (The CD may already be there.)

2) When the contents of the CD-ROM are displayed, double-click the file start.htm. Alternatively, you can get started by clicking the Windows Start button, selecting Run..., then Browse to find the CD-ROM drive. View Files of type: All Files, select start.htm, then Open, and OK. The program has a routine to check for necessary software components on your PC, which should already be present. Click the Start Application button when it appears.

3) The CD-ROM will now load. The Table of Contents appears in the left-hand part of the window. Find the chapter on the Quaternary Pump and click to expand its contents. Next find Repairing the Pump, and expand its contents to see the Simple Repair Procedures. Simple repairs are those that can be done from the front of the module without removing the module from the instrument stack.

4) Under the Simple Repair Procedures, you will see a list of procedures. The ones that have a video recorder icon next to them have a video clip as part of the repair procedure. For practice, select the procedure for Exchanging the Pump Seals and Seal Wear-in Procedure.

5) The instructions for this procedure will appear on the right side of the program window. The information provided includes: When required, Tools required, Parts required, Preparation and Completion Steps, and the step by step directions. You can scroll down and read all the directions or you can run the video clip by clicking the start button at the lower left side of the video area. Once started, the start button becomes a pause button. Buttons to stop the video clip and to adjust the volume are also present.

6) Note: You must have speakers or the headphones installed in order to use the audio portion of the presentation.

7) Now try to find the procedure for changing the needle assembly in the autosampler and play the video for this maintenance procedure.

NOTE: Some of the maintenance procedures will require you to use the ChemStation software to move a part of the instrument. For instance, to change the needle, the needle position must be moved up and down. In order to perform this function, you must go to the Diagnosis view, select the Maintenance menu, then ALS, and Maintenance Positions. When you are ready to begin the maintenance procedure, you would select Start in the Change Needle box. Changing the piston, changing the gripper and parking the arm for transport are also performed from this window.
Other important information found on the Maintenance and Repair CD includes **Part and Materials**, where you can find diagrams of instrument assemblies and part numbers, and information such as **Optimizing Performance** for each of the modules. Browse the contents of the CD as time allows and familiarize yourself with its contents.
Routine Maintenance

Using the CD-ROM, perform the instrument maintenance listed below. If you have any questions during this part of the laboratory, please contact your instructor. Please reuse old parts for the purposes of this laboratory unless otherwise instructed.

Pump Maintenance

- Replacing the Outlet Ball Valve
- Replacing the Purge Valve or Frit
- Removing and Disassembling the Pump Head
- Replacing the Pump Seals
- Reassembling the Pump Head

Autosampler

- Replacing the Needle Assembly
- Replacing the Needle Seat Assembly
- Replacing the Rotor Seal
- Replacing the Metering Seal and Plunger

Diode Array

- Exchanging the Lamp
- Repairing the Standard Flow Cell (View this procedure, but do not perform)
Instrument Tests

The tests have been saved for the end of the laboratory in order to make certain the instrument is still functioning well.

1) In the Diagnosis view, select Diagnosis, then Tests....
2) Perform the following tests using the step-by-step instructions provided on the ChemStation:

- Pressure Test
- Leak Test
- Injector Steps
- DAD Self-Test.
Lab Exercise: Overview and Diagnostics for the Agilent-SL Series
In this Laboratory You Will:

- Learn to correctly identify the hardware elements and flow path of the Agilent 1200 SL Series modules.
- Learn how to track errors and use the logbook.
- Learn how the LC Diagnostic Tool can help you diagnose problems.
- Learn how to set EMF Limits.
- Become familiar with the Maintenance and Repair CD-ROM.
- Become familiar with some maintenance procedures and tests.

Overview of Equipment and Tools Used

- Agilent 1200 Series HPLC- SL, HPLC-grade water in channel A and HPLC grade methanol, acetonitrile, or isopropanol in channel B.
- ChemStation equipped with HPLC ChemStation Software and speakers.
- The Agilent LC Diagnositc Tool.

Consumables

- Agilent 1100 Maintenance and Repair CD-ROM (01100-60007)
  The procedures on this CD apply to some components on the SL. A new CD will be available sometime in 2007.
The Agilent 1200 - SL Flow Path

Please locate the items listed below with your instructor and fill in the table provided.

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solvent Reservoir</td>
<td></td>
</tr>
<tr>
<td>Solvent Inlet Filter</td>
<td></td>
</tr>
<tr>
<td>Vacuum Degasser</td>
<td></td>
</tr>
<tr>
<td>Active Inlet Valve</td>
<td></td>
</tr>
<tr>
<td>Pump Head</td>
<td></td>
</tr>
<tr>
<td>Absorber Capillary</td>
<td></td>
</tr>
<tr>
<td>Outlet Ball Valve</td>
<td></td>
</tr>
<tr>
<td>Damper</td>
<td></td>
</tr>
<tr>
<td>Purge Valve</td>
<td></td>
</tr>
<tr>
<td>Mixer</td>
<td></td>
</tr>
<tr>
<td>Injection Valve in Autosampler</td>
<td></td>
</tr>
<tr>
<td>Metering Device</td>
<td></td>
</tr>
<tr>
<td>Sample Loop</td>
<td></td>
</tr>
<tr>
<td>Needle Seat</td>
<td></td>
</tr>
<tr>
<td>Needle Seat Capillary</td>
<td></td>
</tr>
<tr>
<td>Column Compartment</td>
<td></td>
</tr>
<tr>
<td>Column ID Tag and Sensor</td>
<td></td>
</tr>
<tr>
<td>Detector Lamps</td>
<td></td>
</tr>
<tr>
<td>Detector Flow Cell</td>
<td></td>
</tr>
</tbody>
</table>
Error Messages and the Logbook

When an error (blockage, component failure, etc.) occurs on one of the Agilent 1200 Series modules, the tool in the Method and Run Control view that represents that component will turn red and the Run Status window will display a Not Ready message. Information about the error may be found in the bubble above the module tool. To obtain more information, open the Logbook. In this exercise, you will simulate a blockage by lowering the maximum pressure limit to demonstrate these features.

1) Enter the Method and Run Control view of the Online session. Select the Instrument menu, then Setup Pump.... Lower the Max Pressure limit to 10 bar. Set the flow rate to 1.00 mL/min. OK the panel.

2) Again, under the Instrument menu, select System On. In a few moments, the instrument will shut down and the error will be displayed. Note the red color and the information presented in the bubble.

3) From the View menu, select Logbook, Current Logbook. The top entry in the logbook was the last entry, in this case, the error. The information displayed is:

4) To find out more about the error, double click on the logbook entry. The on-line help will appear. Scroll through the error listings until you have found the above error. The on-line help can be a good starting point to diagnose an error. Close the Help and the Logbook.

5) Return the Max Pressure setting to 600 bar so that you may continue.
Agilent LC Diagnostic Tool

The Agilent 1200 Series HPLC-SL modules are shipped with a tool to help you: 1) troubleshoot problems such as high pressure errors, 2) perform diagnostic tests, such as the pressure test, 3) perform calibrations, 4) provide you with a means to determine when instrument maintenance should be performed, Early Maintenance Feedback (EMF), and 5) provide instrument status reports. In this section, you will explore the software to become acquainted with its layout and function. In later sections, you will perform diagnostic tests and maintenance from this software.

Early Maintenance Feedback (EMF)

The Early Maintenance Feedback system allows the user to schedule preventive maintenance based upon instrument usage. For instance, seals may be replaced based upon seal wear and the rotor seal may be replaced based upon the number of valve switches. The analyst inputs usage limits based upon previous maintenance experience. For instance, if the rotor seal previously failed after 20,000 injections, a limit of 18,000 valve switches might be inserted as the EMF valve switch limit. When 18,000 injections have been made, the EMF indicator found in the Method and Run Control view would change from a green check mark to a yellow question mark indicating that one of the EMF limits had been reached. In this part of the laboratory, you will practice inserting EMF limits and observe the EMF indicator.

1) Go to the Diagnosis view. Double click on the Agilent LC Diagnostic tool found in the Explorer and then Start the tool.

2) Access the Tools button.

3) Highlight the EMF Editor, then Start.

4) In the Instrument/Module Selection tree, select the pump.

5) Highlight the Seal Wear line. To test the EMF system, set the seal wear limit 2 units above the actual seal wear then Set Limit. Note: The seal wear counter increases as a function of both flow rate and pressure. If your system does not have a column installed, the pressure will be quite low. In
this case you may want to set the flow rate to 2-3 mL/min so that the seal wear counter will change more quickly.

6) Return to the Method and Run Control view. Notice that the check mark on the EMF indicator is currently green. Under the Instrument menu, select System On or turn the pump on at the System Diagram. In a few moments, the EMF indicator will change from green to yellow, indicating that one of the set limits has been exceeded (in this case the seal wear limit).

7) **Note:** Exceeding an EMF limit will not shut down your system or abort any method or sequence. It simply changes the appearance of the EMF indicator.

8) When the EMF indicator is yellow, the user should go to the Agilent LC Diagnostic tool and examine the EMF counter to find out what preventive maintenance is due by comparing the Value and the Limit values.

9) Reset the Limit to its original value.

10) Back out of the software until you are on the main LC Diagnostic page.

**Diagnosing Common Problems**

The Guided Diagnostic tool contains software to help you find the root cause of a problem such as Unstable pressure or excessive pressure ripple.

1) Click on the Guided Diagnositc tool.

2) Select a symptom from the drop box.

3) Follow the troubleshooting guide to see how you can use this tool.

4) Back out to the main menu of the LC Diagnostic tool.

**Instrument Tests**

The LC Diagnostic tool contains a complete selection of diagnostic tests such as the pressure test. The tests are a convenient resource to track instrument performance. For instance, users often want to test the lamp intensity. A test is available for that purpose.

1) Select the Tests tool.
2) The **Test Selection** panel is displayed. Select the detector in the drop-down box. A list of tests available for the detector is shown.

3) Click on **Intensity Test**. A description of the test is shown by clicking on the **More…** button. The **Start** button is found below for beginning the test.

4) Explore the other available tests, but do not run any just now. You will run some of these tests later.

5) Select **Back** to leave the **Test** module.

### Maintenance and Repair CD-ROM

When a diagnostic test procedure, Early Maintenance Feedback, or your own experience indicates that maintenance should be performed, two resources can help. First, each of the 1200 instrument modules has a detailed, systematic reference manual. In addition, the Maintenance and Repair CD-ROM (part number 01100-60007) can lead you through each maintenance procedure in a multi-media format. The CD-ROM is easily accessed through the **Diagnosis** view or can be viewed independently of the ChemStation software simply by accessing your CD-ROM drive. In this part of the laboratory, you will learn how to use the maintenance CD-ROM and then learn to perform user maintenance procedures on the 1200 modules. A new CD-Rom for the 1200- SL modules will be available in 2007.

1) Insert the HPLC Maintenance and Repair CD into the CD-ROM drive. (The CD may already be there.)

2) When the contents of the CD-ROM are displayed, double-click the file **start.htm**. Alternatively, you can get started by clicking the Windows **Start** button, selecting **Run…**, then **Browse** to find the CD-ROM drive. **View Files of type: All Files**, select **start.htm**, then **Open**, and **OK**. The program has a routine to check for necessary software components on your PC, which should already be present. Click the **Start Application** button when it appears.

3) The CD-ROM will now load. The Table of Contents appears in the left-hand part of the window. Find the chapter on the **Quaternary Pump** and click to expand its contents. Next find **Repairing the Pump**, and expand its contents to see the **Simple Repair Procedures**. Simple repairs are those that can be done from the front of the module without removing the module from the instrument stack.

4) Under the **Simple Repair Procedures**, you will see a list of procedures. The ones that have a video recorder icon next to them have a video clip as
Lab Exercise: Overview and Diagnostics for the Agilent-SL Series

Agilent LC Diagnostic Tool

part of the repair procedure. For practice, select the procedure for **Exchanging the Pump Seals and Seal Wear-in Procedure**.

5) The instructions for this procedure will appear on the right side of the program window. The information provided includes: When **required**, **Tools required**, **Parts required**, **Preparation and Completion Steps**, and the step by step directions. You can scroll down and read all the directions or you can run the video clip by clicking the start button at the lower left side of the video area. Once started, the start button becomes a pause button. Buttons to stop the video clip and to adjust the volume are also present.

6) **Note:** You must have speakers or the headphones installed in order to use the audio portion of the presentation.

7) Now try to find the procedure for changing the needle assembly in the autosampler and play the video for this maintenance procedure.

8) **NOTE:** Some of the maintenance procedures will require you to use the ChemStation software to move a part of the instrument. For instance, to change the needle, the needle position must be moved up and down. In order to perform this function, you must go to the **Diagnosis** view, select the **Maintenance** menu, then **ALS**, and **Maintenance Positions**. When you are ready to begin the maintenance procedure, you would select **Start** in the **Change Needle** box. Changing the piston, changing the gripper and parking the arm for transport are also performed from this window.

9) Other important information found on the Maintenance and Repair CD includes **Part and Materials**, where you can find diagrams of instrument assemblies and part numbers, and information such as **Optimizing Performance** for each of the modules. Browse the contents of the CD as time allows and familiarize yourself with its contents.
Instrument Status Report

You can print a status report for your own use or for a Service Engineer.

1) Select the Instrument Status Report tool.

2) Fill in the required information and Generate Report.

3) Examine the report details.

4) Press the Back button to return to the main menu.
Routine Maintenance

Using the CD-ROM, perform the instrument maintenance listed below. If you have any questions during this part of the laboratory, please contact your instructor. Please reuse old parts for the purposes of this laboratory unless otherwise instructed.

Pump Maintenance

- Replacing the Outlet Ball Valve
- Replacing the Purge Valve or Frit
- Removing and Disassembling the Pump Head
- Replacing the Pump Seals
- Reassembling the Pump Head

Autosampler

- Replacing the Needle Assembly
- Replacing the Needle Seat Assembly
- Replacing the Rotor Seal
- Replacing the Metering Seal and Plunger

Diode Array

- Exchanging the Lamp
- Repairing the Standard Flow Cell (View this procedure, but do not perform)
Instrument Tests

The tests have been saved for the end of the laboratory in order to make certain the instrument is still functioning well.

1) Open the LC Diagnostic tool go to the Tests section and Tools section (injector steps).
2) Perform the following tests using the step-by-step instructions provided on the ChemStation:

- Pressure Test
- Pump Test
- Injector Steps
- Intensity Test.
Lab Exercise: Integration
In this Laboratory You Will:

- Perform autointegration.
- Integrate using the Events Table.
- Add Timed Events.
- Use Manual Events.
Integration Preparation

ChemStation revisions B.01 and higher have a new, more efficient and accurate integrator than previous revisions. During this lab exercise, practice integration using the data file, Integration.d.

1) Enter the Data Analysis view. Using the Load Method Tool, load the method, DEF_LC.M.

2) From the File menu, select Load Signal… Under the Data folder, find the file Integration.d. Load the data file.

You are now ready to begin integration.
Auto Integration

One of the easiest ways to obtain initial integration events is through Auto Integration. Auto Integrate determines initial values for the slope sensitivity, peak width and area reject. First, however, you will display the default events.

1) Click on the Integration tool, then the Edit/Set Integration Events Table tool or from the Integration menu, select Integration Events.

Record the Default initial events here:
Initial Slope Sensitivity__________
Initial Peak Width__________
Initial Area Reject__________
Initial Height Reject__________
Initial Shoulders__________

2) The chromatogram in front of you was integrated using these values.
3) Examine the chromatogram for improper integration. Check for placement of tic marks and position of the baseline.

Question: Were the default values appropriate?

4) You may print a copy of the chromatogram by choosing the Display Graphics Task tool then the Printer tool, and Print. (File menu, Print, Selected Window, Print).
5) Using the Events Table drop box, select signal DAD1 B Specific.

6) To **Auto Integrate**, select the Integration tool then the Auto Integrate tool or select the **Integration** menu, then **Auto Integrate**. When asked if you want to save the changed events table, reply No.

7) View the events and chromatogram that were created for Signal B.

8) Now see what happens when you add the recommended **For All Signals** settings:

   - Tangent Skim Mode: New Exponential
   - Tail Peak Skim Height Ratio: 3.00
   - Front Peak Skim Height Ratio: 6.00
   - Skim Valley Ratio: 20.00
   - Baseline Correction: Advanced
   - Peak to Valley Ratio 500.00

   **Note:** Auto Integrate does not set the For All Signals Integration Events. You must set these manually.

10) Use Auto Integrate again. Again, do not save the changed events table. Print the chromatogram to notice any differences. You may want to print this chromatogram for comparison and record the event settings below.

   Did you see any improvement?

   - Initial Slope Sensitivity
   - Initial Peak Width
   - Initial Area Reject
   - Initial Height Reject
   - Initial Shoulders
Integrate Using the Events Table

Now, you will set up integration events for the Integration.d chromatogram using the approach discussed in lecture.

1) Click on the Integration tool, then the Edit Integration Events tool.

2) Using the signal drop box, select DAD1B Specific.

3) Set the Slope Sensitivity to 50.

4) Estimate the peak width from the initial integration. Use the smallest peak width from a real chromatographic peak, not noise.

5) Set the initial height and area reject to zero. Set the Shoulders to OFF.

6) Set the Tail Peak Skim Height Ratio to 3, the Front Peak Skim Height Ratio to 6, and the Skim Valley Ratio to 20.

7) Set the Baseline Correction mode to Advanced with the Tangent Skim Mode set as New Exponential.

8) Integrate using the integration tool and view the results.

9) Print the chromatogram and notice any differences in integration.
Adding Timed Events

At times, the initial events are not able to properly construct baselines or place tic marks for integration. Timed events may be added to improve integration. In this section, you will learn how to add timed integration events to your method.

1) Open the Select an event drop box.

2) To practice with timed events, select the timed event, Integration.

3) Move the line that appears in the chromatogram to time=0 and click. Note that you have turned the integrator off at the beginning of the run.

4) Move the line to time=3 minutes and click. Note that you have turned the integrator on at 3 minutes (the events appear in the Events Table).

5) Reintegrate the chromatogram. This may be accomplished by selecting the Integrate current Chromatogram(s) tool

or by selecting the Integration menu, then Integrate.
Lab Exercise: Integration
Adding Timed Events

6) Practice adding other timed events.

Note, you can also add and remove timed events with the tools shown below. Practice this now.

7) When finished, delete all timed events by selecting the event then clicking the remove event tool shown above.

8) Exit the Integration Events using the Exit and save events to method tool.

NOTE: Once the appropriate events are found, they must be saved as part of the method. Save to the method with the Save current Method tool, or from the File menu, select Save, Method. You do not need to do this here.
Using Manual Events

Manual integration allows you to integrate specific peaks or groups of peaks with complete control. For example, you may set the integration start and stop points of any chromatographic peak yourself. This type of integration is convenient, but may not be applicable from run to run. It also may not be as reproducible from operator to operator.

1) Select the Manual Integration: Remove integrated Peak(s) from the Integration Results tool. Note: Integration Events must be closed to manually integrate.

2) Draw a rubber band box around one of the chromatographic peaks including the integration start and stop tic marks. Notice that the peak is no longer integrated.

3) Magnify an area of the chromatogram.

4) Now select the Manual Integration: Draw Peak Baselines(s) and integrate tool or select the Draw Baseline selection from the Integration menu. Draw in the baseline using the left mouse button. The Area is displayed to the side after the integration is accomplished.

Other manual integration events include: Negative Peaks, Tangent Skim, Split Peak, and All Valleys. Practice with these manual events.

Copying Manual Integration Events to a Method

The software allows you to copy the integration events you defined using manual integration to the currently loaded method using the Copy Manual Events to Method item from the Integration menu. These manual events are then stored separately in the method. They cannot be reviewed in the Integration Events dialog box. When a signal is loaded they are only applied when the Apply Manual Integration option is checked in the Integration Events or when you select Apply Manual Events from method in the Integration menu. To see how this task works, do the following.
Lab Exercise: Integration

Using Manual Events

1) Select **Copy Manual Events** to Method in the **Integration** menu.
2) Select the Edit/Set Integration Events Table tool to display the integration events.
3) Integrate the chromatogram using the Integrate Current Chromatograms tool.
4) Notice that the manual integration events have not been applied.
5) Click in the Manual Events box and re-integrate the chromatogram (this box is located integration events section of the window on the left side).
6) Notice that the manual events are now applied to the integration.
7) Deselect the checkbox and re-integrate. Note that the events are no longer applied.
Lab Exercise: Quantification
Lab Exercise: Quantification

In this Laboratory You Will:

- Run three external standards to create a calibration table.
- Select appropriate integration parameters and save them to your method.
- Build a three level calibration table.
- Test the calibration table.
- Print a basic report.
Preparations

Obtain the low, medium and high standards. Insert them into vial positions 1, 2 and 3 of the autosampler. Turn on the detector lamp. Prime your solvent delivery system.

**Priming the Agilent 1100 or 1200 Solvent Delivery System**

1) If you are equipped with a vacuum degasser, make certain the degasser is on.

2) Ensure that the outlet tube is connected from the purge valve to the waste container. Open the purge valve located on the pump module by turning the knob counter clockwise several turns.

3) To prime the solvent delivery system, you should pump 100% at 5 mL/min from each channel for several minutes. To accomplish this task, select the following menu items: **Instrument, Set up Pump...**; or click on the pump set up GUI in the system diagram (shown below), then **Set up Pump**.

4) Type in a flow of 5.000 mL/min and %B of 100. **OK** the dialog box.
Lab Exercise: Quantification

**Preparations**

5) To turn the solvent delivery system on, you may use the menu items: **Instrument, More Pump, Control**; or access the tool shown in the diagram below. Do this now.

6) Wait until a steady stream of solvent comes out of the purge valve waste tube.

7) Repeat steps 3 through 6 for the other channels of the pump. Complete the priming process by setting the composition to %B=65 and pump at 5 mL/min.

8) Change the flow rate to 1.5 mL/min and then close the purge valve. Allow the column to equilibrate.
Creating the Acquisition Method

1) Load the default method, DEF_LC.M as a starting point for method creation (Method, New Method) or double-click on DEF_LC.M in the ChemStation Explorer. From the Method menu select Edit Entire Method…. Select only the Instrument/Acquisition section for editing. OK this dialog box.

2) Fill in the following parameters for the solvent delivery system:

   ![Set up Pump: Instrument 1](image)

   OK the dialog box.

3) Select a Standard Injection with a 5 µl injection volume. OK the dialog box.

4) Fill in the DAD Signals as below. OK the dialog box.
Note: If a VWD detector is being utilized, select the same wavelength as signal A.

5) Set the column compartment temperature to 40°C (both left and right). **OK** the dialog box.

6) From the **Method** menu, select **Save Method As...**. Name the method **Quant.m**.

7) Type in a short comment for the Method History and **OK**.

8) Turn on the pump and equilibrate the HPLC column for several minutes with 30% water/70% acetonitrile.
Data Acquisition-Standards

In this example, you will run each sample individually, not as a sequence. Of course, it is possible to run the three standards in sequence mode.

1) From the **RunControl** menu, select **Sample Info...**. The same panel may be accessed from the tool:

![Sample Info Instrument 1](image)

Fill in the information for the low level standard and **OK** the dialog box.
2) Check that your baseline and pressure are stable.

3) Start the run either from the Start tool or from the RunControl menu, then Run Method.

4) Now acquire data for the medium standard and the high standard as well. Call the data files, med.d and high.d, respectively. When you have finished, turn off the pump.
Integration

In this section you will optimize the integration events for the analysis and save them to the method.

1) Go into the Data Analysis view.
2) From the View menu, select Preferences.
3) Select the Signal Options tab. Make certain that integrate after load is the only box checked.
4) Find your data analysis directory in the ChemStation Explorer. Double-click on the Single Runs to place the files in the Navigation Table. Find the data file, Low.d, and load all signals. The data file is initially integrated using the default integration events. Make certain both signals A and B are present.
5) After loading, go to the Integration menu and select Integration Events or select the Select Integration Task tool, then the Edit/Set Integration Events Table tool.

6) Select DAD Default for the Events Table and insert the following integration events:

   Tangent Skim Mode: New Exponential
   Tail Peak Skim Height Ratio: 3
   Front Peak Skim Height Ratio: 6
   Skim Valley Ratio: 20
   Baseline Correction: Advanced
   Peak to Valley Ratio: 500
   Slope Sensitivity: 50
   Peak Width: Set to the narrowest real chromatographic peak
   Area Reject: 0
   Height Reject: 1
   Shoulders Off

7) Reintergrate the chromatogram using the new events. Either select the Integration menu then Integrate, or the Integrate tool.
8) Examine the current integration. Change settings appropriately. Remove undesirable peaks (there should be four main peaks) using either the area reject or timed events.
Lab Exercise: Quantification

Integration

9) Check the integration for signal B as well. Make certain that both signals are mapped to the DAD Default Events Table by selecting the tool, or if you choose, create different events for each signal.

10) Exit and save the events to the method using the Exit and save events to method tool. Then, resave the method, Quant.m.
Setting up Signal Details

The Signal Details dialog box describes which signals will be evaluated during a method run. Signals that are not in the list box will not be integrated or reported if all defined signals can be found in the current data file. Whenever the defined signals cannot be found the system loads all available signals from the data file and tries to generate the report.

1) From the Calibration menu, select Signal Details…. You may also access the Signal Details dialog box by first selecting the Calibration Task tool, then the Edit current method signals tool.

![Image of the Calibration menu with Signal Details button selected]

2) Pull down the Available Signals and select DAD1A, Sig=250, 100 Ref=360,100. Now select the Add to Method button. Repeat with signal B. OK this dialog box.

3) Resave the method.
Building a Calibration Table

You have already loaded and integrated the lowest level standard. The first step toward building your calibration table will be to select the calibration settings.

1) In the **Calibration** menu, select **Calibration Settings...**
2) Fill in the **Title** of the Calibration Table, e.g., **Class**.
3) You will **Use Sample Data** From Data File.
4) Type in $\mu$g/mL for **Amount Units**.
5) The Default RT Windows should be set at **5%**.
6) Select No for Calculate Uncalibrated Peaks.
7) If you do not understand any of these entries, read the online help. **OK** this dialog box.
8) Under the **Calibration** menu, select **New Calibration Table...** or, select the New Calibration Table from current chromatogram tool.

![](Integration-Calibration-Signal.png)

9) Select **Automatic Setup Level 1**. You may select a default amount for all peaks or fill in the amount after entering the calibration table. For your current purposes, leave the **Default Amount** as 0.00. Do not check the box to **Calculate Signals Separately** because we will be using qualifiers. **OK** the dialog box.

10) The calibration table now appears. You will be calibrating the last two of four major chromatographic peaks. Locate the third major chromatographic peak at approximately 1.9 minutes (for a mobile phase of acetonitrile). Use the signal that provides the most area counts.

11) Click in the **Compound** column, and type in **Biphenyl**; selecting the signal that gives you the most area counts. In the **Amt[$\mu$g/ml]** column, type in **0.8**. Scroll to the right and make this a reference peak. If you do not see the reference peak as an option, make certain that you are currently in the **Overview** portion of the calibration table. This selection can be found in the pull down box in the middle of the window.
12) Now find the last major peak at approximately 3.3 minutes. The compound name is \textbf{o-terphenyl} and the amount is \textbf{2.4 µg/mL}. Select the signal that provides the most abundant area counts. You will also make this a reference peak.

13) \textbf{OK} this initial Calibration Table to remove lines with zero amounts. This step will make building your table easier.

14) From the \textbf{Calibration menu}, select \textbf{Calibration Table} to redisplay the Calibration Table.

15) Save the method.

16) Now, load all signals for data file, Med.d, the medium standard. The integration will be performed automatically using the integration events chosen for the last data file.

17) Under the \textbf{Calibration menu}, select \textbf{Add Level} or select the Add new level from current chromatogram tool. This time, \textbf{Level 2}. \textbf{OK} the box.

18) Fill in the amount fields only. For level 2, Biphenyl is \textbf{2.4 µg/mL} and the \textbf{o-Terphenyl} is \textbf{7.2 µg/mL}.

19) Now load the high-level standard, \textbf{high.d}. Select \textbf{Add Level}. This data file is for level 3.

20) The amounts for the third level are: Biphenyl, \textbf{8.0 µg/mL}, and \textbf{o-Terphenyl}, \textbf{24 µg/mL}.

21) You may click on the chromatographic peak in the chromatogram to view the corresponding calibration curve in the lower right hand corner. You may change the curve fit by selecting \textbf{Peak Details} from the \textbf{Calibration Table Option Set} drop box found in the middle of the window. Now the Calibration Table contains a \textbf{Curve Type} and \textbf{Origin} column. Select a \textbf{Linear} curve type and \textbf{Ignore} the origin.
Setting up Low and High Amount Limits for Calibration Standards

You may specify low and high amount limits in the calibration table. If the calculated amount is outside the limits, a warning appears in the report. The amount limits can be used as qualifiers to confirm the peak identification. Compounds that are outside of the amount limits, are not used to recalibrate the Calibration Table. The minimum and maximum amounts limits do not consider a multiplier value that you may have specified.

1) From the Calibration menu, select Calibration Table Options..., then Compound Details or change from Overview to Compound Details in the drop box located in the middle of the window.

2) Click in the box presented to the left of the Low Limit column while in the biphenyl row. Now click in the Low Limit cell. A lower limit is automatically calculated. This is a lower limit of -20%.

3) Click in the box presented to the left of the High Limit column while in the biphenyl row. An upper limit will appear in the cell. This is an upper limit of +20%. The default is +/- 20%, but you may set any desired limits.

4) Repeat this procedure for the o-terphenyl peak.

5) Resave your method.
Setting up Qualifiers (Diode Array only)

A qualifier peak is used to confirm that the main peak within the retention time window belongs to the expected compound. It is assumed that the peaks of one compound have a constant response ratio at two different wavelengths. The qualifier peak response is a percentage of the main peak response.

1) Change from Compound Details to Identification Details either in the drop box or through the menus: Calibration, Calibration Table Options..., Identification Details.

2) Identify the Pk Usage column. Note that one signal for the biphenyl peak is designated as the Main peak.

3) Notice the other signal. Change the peak usage from Ignore to Qualifier for one of the peaks. The expected ratio is shown with a +/- 20% window.

4) Set up a qualifier for the o-terphenyl compound as well.

5) Resave the method. Type in a comment for method history.

You have now set up two curves with qualifiers. In the next section you will test your calibration table and print a simple report.
Lab Exercise: Quantification
Testing the Calibration Table

Testing the Calibration Table

1) Load the medium standard's data file, med.d. Go to the Report menu, then Specify Report... or select the Specify Report Calculation and Print Style tool.

![Specify Report Image]

2) Make the following selections:
   Destination = Printer and Screen
   Calculate = ESTD
   Based on = Area
   Report Style = Detail
   Select chromatogram output.

3) OK the report specifications and save this to your method.

4) From the Report menu, select Print Report or select the Identify Peaks, calculate Results & print Report tool.

![Print Report Image]

5) Study the resulting report and modify retention time windows or qualifiers if necessary. Remember to resave the method if you are satisfied with report style.
Lab Exercise: Running a Sequence
In this Laboratory You Will:

- Build a sequence with automated recalibration of the existing calibration table.
- Learn how to pause and restart the sequence.
- Print a Sequence Summary report.
- Access the Sequence Logbook.

Sequence operation allows you to perform unattended analysis of more than one sample, using more than one method. In this exercise you will utilize the method, including the calibration table, created in the last exercise. Place the low, medium, and high calibration standards in vial positions 1, 2, and 3, respectively. Place the isocratic test mix in position 4.
Building a Sequence

1) Go to the Method and Run Control view.

2) Under the Sequence menu, select New Sequence. This menu selection loads the default sequence template. You may also access this option by clicking on the sequence tray setup tool located on the left hand side of the screen.

3) Under the Sequence menu, find Sequence Parameters….

4) Fill in the Operator Name. Create a subdirectory using your last name. Do not change the Path. Select Auto for the data file naming system.

5) For Part of methods to run, select According to RuntimeChecklist.

Question:
What is the purpose of the WaitTime?

6) Select the Post-Sequence Cmd/Macro checkbox, then from the drop box, STANDBY. Enter a nRdy Timeout of 30 minutes. OK the dialog box.

Question:
What is the difference between the STANDBY option and Shutdown.mac?
7) Now enter the **Sequence Table** from the **Sequence** menu or from the sequence tray setup tool. You would like to do the following:

a) Replace all existing calibration table response factors with new response factors at all three calibration standard levels.

b) Thereafter, perform cyclic recalibrations every 2 sample injections averaging the response factors and retention times.

c) Perform four sample injections, in this case utilize the vial containing your isocratic test mix and make four injections from this vial.

Fill in the table. Each time you wish to add a new line to the bottom of the table, highlight the last line by clicking on the line number, then use the **Append Line** button. To add a line above the currently highlighted line, use the **Insert** button. The table should look like the one below. You can also try to use the **Insert/FillDown Wizard**.
8) **OK** the Sequence Table after completing the entries and save the sequence either through the Save Current Sequence tool or through the Sequence menu.

9) Select **Sequence>Partial Sequence** to view the injection order that will be followed by your Sequence Table. **Cancel** out.
Sequence Summary Reports

The ChemStation can print a variety of standard reports for individual sample analyses as directed in the Specify Report panel. These styles are stored as part of the method and are printed at the end of each analysis if desired. Sequence summary reporting is an additional, optional way of reporting. You may calculate and report parameters across a number of different analyses, for instance, you may report the standard deviation of the retention time for calibration standards. These calculations are useful, for example, to test instrument performance or the stability of a new method. You will add a sequence summary report to this sequence. This type of report will print at the end of the entire sequence.

1) To begin setting up your sequence summary report, select Sequence Output from the Sequence menu or from the sequence tray setup tool.

2) Select the Print Sequence Summary Report option along with the Report to Printer and Print individual reports for each run as well, options.

Question:
If you had not selected Print individual reports for each run as well, would you receive an individual report after each sample had been run?

3) Specify the destination for individual reports as the Printer, as specified here, not as specified with each method.

4) Click on the Setup... button. Select items 4-9. For items 7 and 8, select Extended Statistic. For item 9, select Sample Summary. OK this dialog box and the Sequence Output dialog box.

5) To specify the Extended Statistics, go to the Sequence menu and select Extended Statistics…. Select any item you would like calculated by double clicking the Active box. Note that you can place limits in the field to the right that will be marked in the report if exceeded. OK this dialog box.

6) Resave the sequence.
Starting the Sequence

1) Make certain that **Quant.M** is currently loaded.

2) View the **RunTime Checklist** (under the **Method** menu). Make certain that both **Data Acquisition** and **Data Analysis** are selected. In previous exercises, data acquisition was the only item selected.

3) Turn on the pump, column thermostat, and detector. Allow the column to equilibrate.

4) When you have a stable baseline, start the sequence either from the **Start** tool or **RunControl, RunSequence**.
Pausing a Sequence

1) Pausing a sequence to run a priority sample is quite easily accomplished. Pull down the Run Control menu and select Pause Sequence.

   The current sequence will pause after the current method has completed. You can make changes in the sequence for those samples that have not yet been injected.

2) To resume the sequence, select Resume Sequence from the Run Control menu. The sequence continues with the next run.
Post Sequence

1) Examine the printed reports. How did your sequence go?

2) If you have errors during your sequence, it may be helpful to print the Sequence Logbook. To do this, go to the View menu. Select Logbook, then Sequence Logbook. To print this logbook, select Print Logbook after you have displayed the logbook on the screen. The logbook can be displayed with the Sequence Logbook tool, as well.

3) Alternatively, open My Computer and find the sequence folder and the sequence logbook. Examine the sequence folder entries created by your sequence.
Lab Exercise: Sequence Review and Reprocessing
In this Laboratory You Will:

- Load a sequence into the sequence navigation table.
- Reprocess a sequence after changing the folder method.
- Reprocess a sequence after updating DA methods.
- Use Batch Review to review a sequence.

You will need the following data:

- Batch.B
- SEQUENCECLASS 2006-03-20 13-48-40, found in the folder Chem32\1\Data\03-20-06
- CLASSSEQUENCE 2006-03-15 10-46-09 found in the folder, Chem32\1\Data\03-15-06.

Please note that the sequence container names are similar! One starts with SEQUENCECLASS and the other startw with CLASSSEQUENCE. Be sure to use the correct file.
Reprocess with Sequence Folder Method

You will reprocess a sequence after updating the Folder Method. This sequence has two problems. First, calibrated compounds fell outside the method’s retention time windows, and therefore, no amounts were calculated. The retention time windows are set in the Calibration Settings.

In addition, the 4th level of the calibration is out of specifications and needs to be dropped from the analysis. See the report below.
**Lab Exercise: Sequence Review and Reprocessing**

**Reprocess with Sequence Folder Method**

You will update the Sequence Folder Method with new retention time windows and drop the 4th level calibration data point, then reprocess the entire sequence. Note that only the method (.M) and sequence file (.S) in the sequence folder will change. The master method stored in Chem32\Methods and the sequence template stored in Chem32\Sequence will not change.

1) **Go to Data Analysis.**

2) **In the Data Explorer, find the sequence folder: 03-20-06 and expand.** Find the sequence folder: Chem32\Data\03-20-06\SequenceClass 2006-03-20 13-48-40. Double-click to load into the Navigation Table.

3) **Load the container method.** The DA Method for the first file will load automatically as stated in the Preferences. In this part of the exercise, however, you are changing the folder method so the changes apply to all data files. The path for the sequence folder method is: Chem32\Data\03-20-06\SequenceClass 2006-03-20 13-48-40\CLASSQUANT.M. Load the sequence folder method now.
4) First, let’s change the retention time windows so that the amounts will be calculated.

5) Go to the Calibration menu and then Calibration Settings.

6) Change the Default RT Windows as below. OK the dialog box.
Lab Exercise: Sequence Review and Reprocessing
Reprocess with Sequence Folder Method

7) Now, take a look at the calibration curve. Select the **Calibration** menu and then **Calibration Table**.

8) Click next to the 4<sup>th</sup> level row to highlight the line and press the **Delete** button.

9) Remove all level 4 rows from the table.

10) Notice that the Correlation is now improved.

11) Save the sequence folder method.

Always check to make certain you are in the correct directory path. Fill in the change history stating the the retention time window was updated and the 4<sup>th</sup> level calibrator was removed.

12) During the original sequence acquisition, there was quite a large sequence summary report as well as individual data files printed. We do not want to print that much information here. Therefore, we will change the sequence output. This is a sequence, .S file, parameter. The tools shown will allow you to make changes to this file without going to the **Method and Run Control** view.
The Sequence folder .S file is currently loaded. If you want to check this, go to Method and Run Control and check the path.

13) Open the Sequence Output dialog box by clicking on the tool shown below.

14) Deselect **Print individual reports for each run as well. OK** the dialog box.

15) Select the Sequence Summary tool shown below.

Make certain only 5 and 9 are selected. Make section 9, **Summary**, is a **Compound Summary**. **OK** the dialog box.
16) To reprocess the sequence, select the Start sequence reprocessing tool outlined below.

The sequence will reprocess. You will notice that the status bar turns blue to indicate the sequence is reprocessing. The method and a Compound Summary should print at the end of the sequence.

Examine the method. You should see the record of your action in the Change History. Find the calibration table and note that only four data points are now used for the analysis.

The Compound Summary should now calculate amounts for all compounds.

Did you successfully reprocess the data using the sequence folder method?

NOTE: If you reload the sequence from the Explorer, the all DA Methods will update with the folder method changes.
Reprocess with DA Methods

In this section, you will see how to change the individual DA methods. You will add manual integration events to two runs and reprocess.

1) Go to the View menu, then Preferences… >Signal Options.

2) Make certain that **Integrate after load** is selected under Load Signal Options and **Individual Method from Data File** is selected under Method used for Review of Sequence Data. **OK** the dialog box.

Note that this can also be specified directly from the user interface at the top of the Navigation Table. If you change which method is used via this interface, does it take effect immediately? ________________ Is this method choice used for data review or reprocessing? ________________

3) Find the Data folder 03-15-06 and expand. Double-click on the sequence, Chem32\1\Data\03-15-06\ClassSequence 2006-03-15 10-46-09 to load.
Lab Exercise: Sequence Review and Reprocessing

Reprocess with DA Methods

4) You can review the data to check integration by stepping through the files manually or automatically. To step through the files manually, press the tool below.

5) To step through the files automatically, press the button outlined below.

6) To stop, press the Pause button. Practice navigation for a moment.

7) Now we will change individual DA Methods. Load 001-0101.D.

8) Press the Integration button. The manual events become available.

Use the Draw peak baseline and integrate icon to manually integrate both signals of the last peak. Do something significant so that you can trace the result.

9) Go to Integration > Copy Manual Events to Method.

10) Open the Integration Events Table and select Manual Events.

11) Save and Close the Events Table.
12) Resave the DA method. Make certain you have saved the desired changes to the correct method by checking the path. Insert a comment for the method history.

13) Perform the same exercise on 003-0301.D and save its DA method.

In order to use the DA methods for these data files instead of the sequence folder method during reprocessing, you must change the methods in the Sequence Table.

14) Open the Sequence Table using the tool below.

15) You want to use the DA method for samples 001-0101.D, and 003-0101.D. Go to the line in the sequence table that is responsible for the first data file and change the method as below by browsing to the DA method.

16) Note that you will go to Chem32\1\Data\ClassSequence 2006-03-15 10-46-09\001-0101.D\DA.M.

17) Change the method for 003-0301.D as well.

18) Check the Sequence Output and Summary to print only the Compound Summary.
Lab Exercise: Sequence Review and Reprocessing

Reprocess with DA Methods

19) Now, reprocess the sequence. Take a look at the resulting Compound Summary page and compare it to the one at the end of this lab to make certain your changes took affect.
Batch Review

If you generate a large number of samples on a daily basis and would like a convenient way to view the results and check the quality of integration then Batch Review may help. Batch Review allows you to step through calibration standards, control samples, and unknown samples adjusting the integration parameters and reviewing the results of sequence runs.

1) In the Data Analysis view, select Demo\Batch. Find the .b batch file created during the sequence and load demo\batch.b. Every sequence creates a .b batch file.

2) Process the data using Batch.M. You would typically process the batch data using the sequence container method.

3) Select all runs for batch processing. OK the dialog box.

4) Examine the integration for the first data file. If you would like to view a new data file every 10 seconds, press Start.

5) If you want to change the integration events, then Pause the batch review.

6) Try changing the slope sensitivity on one of the data files and reintegrating.

7) Use the Marked changes to current run for save with batch file tool to mark those changes you would like to keep. If you do not want to keep an integration change, select the discard tool.

Note the following additional features before leaving the batch review:

Update the calibration table from all calibrated batch runs
Batch Preview and Batch Report (found under the batch menu), and
Saving the batch.
Lab Exercise: Advanced Reporting
In this Laboratory You Will:

Preview the following report styles:

- GLP
- Performance (System Suitability)
- Automated Peak Purity

You will also learn how to add your own header to report styles.
Adding a Report Header

You may add an individualized header to many of the report styles including: Detail, Header + Short, GLP + Short, GLP + Detail, and Full. The directions presented below will guide you through this process.

1) Go to the Data Analysis view. Load the method, Advrep.M. Try using the Load Method tool.

2) From the Start button, select All Programs, then Accessories.

3) Open Notepad.

4) After Notepad loads, type in information to test the header. Try your name and company address or similar information.

5) Under the File menu, select Save As… The header must be saved as rpthead.txt to the specific method you will use. For example:

   C:\Chem32\1\methods\advrep.m\rpthead.txt

   Save the file as a text document. Make certain the entire path is correct.

6) Exit Notepad (File, Exit).

7) Make certain that you are in the Data Analysis view. Load the data file Lab4m.d by double clicking on the file in the Navigation Table or by selecting File, Load Signal….

8) From the Report menu, find Specify Report. You may also access this panel from the Select Integration Task tool followed by the Specify Report Calculation and Print Style tool.

9) Select the Printer destination, ESTD by Area with a GLP + Detail report style. You may also add a chromatogram output. OK the dialog box.

10) Now from the Report menu, select Print Report or use the Print Report tool.

11) Find your personalized header information on the printed report. The GLP report style was utilized in this example. Note that this report style includes a printout of the run logbook.
Lab Exercise: Advanced Reporting
Adding a Report Header

Note: The GLP report style is not in any way connected to the Save GLP data selection found in the Run Time Checklist. It is simply a report style that includes a printout of the logbook, firmware, serial numbers and some other information.
Performance Reports (System Suitability)

Many chromatographers utilize the Performance report styles to help evaluate the analysis system before and during routine analyses. The information generated for each calibrated peak includes the retention time, \( k' \), symmetry, peak width, plate number, resolution, signal-to-noise ratio, and compound name. You may also determine the noise and drift using a Performance + Noise report style. The results can be compared to expected results automatically.

Note: To evaluate the performance of both the analytical instrument or of an analytical method before routine use, utilize the Sequence Summary function.

Some of the system suitability calculations require the void time or volume. You may also desire column identification within reports. This information must be input prior to sample injection and cannot be input after the fact. The first part of this exercise will demonstrate this process.

1) Go to the Method and Run Control view.
2) Load Quant.M from your previous exercises.
3) Pull down the Instrument menu and select Columns.
4) Fill in the column description, length, diameter, and particle size. Examine previous runs to determine the void time of the column. If you don't know how to find the void time, ask your instructor. Scroll to the right and fill in the value. Select min as the Unit.
5) The Installed field specifies which LC columns are being used. Highlight this field and select YES for the column in your system.
6) OK this window. Resave your method.
7) Return to the Data Analysis menu. Under Report, select System Suitability, then Edit Performance Limits....
8) Fill in low and high limits for chosen criteria in absolute units, for instance, retention times in minutes. The ChemStation will calculate parameters for all the calibrated peaks in your method. If actual values of any one peak exceed the defined limits, this will be noted in the report. You can get an idea of the upper and lower limits for some of the criteria from your Sequence Summary report from the previous laboratory exercise. Fill in this screen now.
9) Noise can be calculated three different ways. First, as six times the standard deviation of the linear regression of the drift; second, as peak-to-peak(drift corrected); and third, as determined by the ASTM method(ASTM E 685-93).
Lab Exercise: Advanced Reporting
Performance Reports (System Suitability)

Select System Suitability from the Report menu, followed by Edit Noise Ranges.

10) Examine prior chromatograms and select several time ranges for the noise calculation. The ranges should be greater than one minute in duration in a region where there are no chromatographic peaks. Fill in the table and OK the dialog box.

11) Now, go to the Report menu and select Specify Report or use the Specify Report tool.

Select an Extended Performance Report Style. OK the dialog box and resave the method. Resave Quant.m.

12) Return to the Method and Run Control view. A complete system suitability report cannot be printed from previously acquired data unless the column information (void time) was filled in prior to the actual data acquisition. Turn on the pump and lamp. Equilibrate the column. Make certain that the method loaded is Quant.M. Under Method, RunTime Checklist, make certain that both Data Acquisition and Data Analysis are selected.

13) From the RunControl menu, select Setup Sample Info. Give this data file the name, syss.d. Set up the autosampler to inject one of the standards or the original test mix. Run the Method.

14) Wait for the report to print and examine the report. Note the < or > sign that appears when the calculated values exceed the specified limits.

Note: The equations for each performance test can be found in your manual, Understanding Your ChemStation.

Automated Peak Purity

The Short + Spectrum, Detail + Spectrum, and Full report styles will produce automated peak purity analyses of calibrated chromatographic peaks.

1) Make certain Quant.M is still loaded. Make certain the last data file you collected is still loaded, Syss.d.

2) To print an automated peak purity report, open the Report menu and select Specify Report or use the Specify Report tool.

3) Change the Report style to Short + Spectrum. OK the dialog box.

4) Resave the method under the File menu or use the Save Method tool.

5) Load a data file from your last sequence run.


Note: Purity Options may be saved as part of the method in order to produce the desired peak purity report.
Automated Spectral Library Search

Make certain that Quant.M and Syss.D are still loaded.

Quantification based solely on retention time correlation can lead to erroneous identification if:

a) Compounds other than the calibrated ones appear in the specified retention time window.
b) More than one peak elutes in the specified retention time window.
c) The compound is retained on the column longer than the specified window because of solvent flow rate changes or changing column characteristics.

The ChemStation can automate a library search process to positively identify chromatographic peaks based upon their UV spectra. In addition, the software can perform a peak purity check using the settings specified in the Purity Options dialog box.

1) To set up a library search report, first go to the Report menu and select Automated Library Search. The Parameters for Automated Identification panel will appear.

2) The libraries you specify in this window must already exist. You created a library for this test mix earlier in the course. Select the checkbox for library 1 and click on the Selection box. Load your library.

3) Click on the Edit SearchParms button to the right. Create a search window of + or - 10%. Set a Threshold of 2 mAU. OK this dialog box.

4) You may perform a purity check. This procedure is recommended before a library search, since a match is only as reliable as the quality of the separation. It calculates and reports a purity factor. Purity can be defined by a threshold, below which questionable results are tagged with an "x" in the report. Select the Purity check? checkbox.

5) Three search modes can be applied to your application. First, select Identify by spectral library search.

This mode is the most general search mode. The ChemStation compares the peak spectra of all those peaks found by the integrator and characterized by their retention times, with spectra from up to four specified libraries. The name of the compound with the best match is assigned to the peak. You can specify how good this match must be with your own threshold value. The ChemStation then refers
to the calibration table for an identically named entry. If one is found, the data are used to calculate and report the amount.

6) **OK** this dialog box. Open the library you intend to use in the report and check that the names of the calibrated peaks are identical with the library names. In other words, check your calibration table as well as the entries in the library.

7) Under **Specify Report**, select **Library Search**. **OK** the dialog box. Resave your method. Print the report.

8) Now, set up a method where the search mode is Target compound analysis using a calibration table.

This search mode is only for those compounds in the calibration table. Peaks are only reported as identified if confirmed by spectral comparison.

9) Print the report.
Lab Exercise: Customized Report Design

A Customized Report Layout view is included in the ChemStation for users who want to define the exact content of their reports. This laboratory will help you develop a customized report. For further information, study the customized report files that are included with the software.
In this Laboratory You Will:

- Build your own customized report template.
- Save the template as part of the standard report options.

You will need the Demo File, 005-0101.D and Democal1.M.
Preparations

1) Enter the Report Layout view. Load the method Democal1.m (Double-click on the file name in ChemStation Explorer, or choose File > Load, Method).

2) Load Signals from the file Demo\005-0101.d. using File > Load > Signals.
1) Under the **File** menu, select **New Template**.
First, add a header and footer to the report style. The header would be reproduced on each page of the report at the top while any footer would appear on each page at the bottom.

2) Next to the Header designation you will see two gray horizontal borders which represent the section start and stop points. Right now, the borders are adjacent with no space between indicating no existing header. Adjust the length of the Header section by clicking on the bottom gray border and dragging about one inch down the page.

3) You will create a header consisting of the data file name and sample name. Click on the Text Tool.

   ![Text Tool](image)

   Click in the white header space and draw a rubber band box the width of a single text line. Release the mouse. The New Element selection box will appear. Select **Raw Data File Name** then OK. The Raw Data File will be left aligned. **OK** this selection.

4) Resize the Raw Data Filename box by dragging the borders to fit the size of the actual element.

   **NOTE:** To delete an element you have already added, click once with the left mouse button within the borders of the element. Go to the **Edit** menu and select, **Delete Element**.

5) Repeat steps 4 and 5, but this time add the **Sample Name**.

6) Reposition the bottom Header border by clicking and dragging the bottom border up to the bottom of the Sample Name.
Adding a General Section

1) Click on the blue triangle. The color will change to red.

2) Select Edit, New Section, General.

3) Expand the General section by dragging the bottom border down.

4) Click on the Text Tool and position a rubber-band box at the top. Select Constant Text, then OK. Type in any address.

NOTE: Use the CTRL and Enter keys simultaneously to move to the next line within a text box. Striking Enter alone is equivalent to selecting OK.

5) Click on the Text Tool again and outline a single line below the Agilent Technologies logo and address. Select Constant Text and type: Injection Data, then OK. Resize the text box appropriately when finished. This text will appear on the report to describe the next field which you will add. Click on the Text Tool again. This time outline a single line to the right of the text: Date of Injection. When the New Element box appears, select Injection Date. OK the dialog boxes.

6) Add the Acquisition Operator in the same manner as above.

7) At this point, you may need to enlarge the white space. Scroll down then click on the border and drag it down the page.

8) Perform the following steps to add a chromatogram. Click on the Graphics Tool.

Outline a rather large box, perhaps 80 x 40. These dimensions can be found in the message line.

9) When the New Element box appears, select Chromatogram, then OK. Select the desired preferences for chromatographic display and click OK.
Inserting Tables

1) Below the chromatogram, expand the size of the general white space.
2) Select the Table Tool,

![Table Tool Icon]

and outline a space approximately 80 x 20.
3) Select Cal. Peaks Sorted by Ret. Time. The Setup Cal. Peaks sorted by Ret. Time table should appear. From the **Printed Columns** box select **Response Factor** then `<`. Note that you have removed this item from the Printed Columns list. Check that the table layout lies within the bounding box length. Remove Expected Retention Time, as well. **OK** the table and adjust the size of the box, if necessary.

Creating a Table Footer

1) Double click on the table box. **Click on the Edit Format button** in the Set-up.
2) When the Edit Format of Cal. Peaks panel is displayed click on **Footer**.
3) **Click on the button labeled 2 Lines.** In the Amount row, Line 2 column, type: `<@sum>`. In the first row (#), Line 2 column, type: **Total.** **OK** this panel. In the Edit Format panel, change the width of the # row to **6.** **OK** this panel and the subsequent panel.

Inserting a Page break

1) **Click on the Page Break Tool,**

![Page Break Tool Icon]

then click in the white space below the table to insert a page break.
2) Reposition the bottom General Section border by dragging the border up to the page break (the blue band).
**Adding a Calibration Curve**

1) Click on the blue triangle found between the General section and the Footer. The triangle will change from blue to red.

2) Pull down the **Edit** menu and select **New Section, Cal. Compounds**.

3) Drag the Cal. Compounds borders to create free white space in this new section.

4) Click on the Graphics Tool.

5) Draw in a rubber band box for the calibration table.

6) When the New Element panel is displayed, select **Calibration Curve**, then **OK**. **OK** the Set-up panel as well.
Finishing Up

1) From the **File** menu, select **Save Template As**. Give the template a unique name.

2) Now test the template. Use the Report Preview tool to display the report.

   Review the report and make any necessary modifications. Resave the template as needed. You may print the report now.

3) You can add your report to the list of report styles by selecting **Add to Report Styles** under the **File** menu. Try this now.

4) Go to the **Data Analysis** view and select **Report, Specify Report**. Find your report style by scrolling to the top of the list of report styles. In order for this style to become part of a method, select this report style and then resave the method.

**NOTE:** You may also remove report styles with the **Remove from Report Styles** menu item found in the **Report Layout** view, under the **File** menu.
Lab Exercise: Commands
In this Laboratory You Will:

- Become familiar with some of the more common commands on the HPLC ChemStation.
- Understand the use of variables.
- Understand the concept of data storage in registers and tables.
- Become familiar with some of the commands used to access/manipulate data.

During this laboratory exercise you will be using the HPLC ChemStation equipped with version B.02.xx software. The data file, demodad.d, from the demo directory will be utilized.
Retrieving Information about Commands

Several resources are available to help you utilize the ChemStation commands. These resources include Online Help and the Show command. Start the exercise in the Data Analysis view.

1) Check to make certain that the command line is displayed at the bottom of the ChemStation software window. If the line is not available, select View then Command Line.

2) Type Show<enter> on the command line. Select the Commands domain and find the File command. Double click on the File command. Notice that the syntax for this command is now printed below the command line.

3) Type in: File, type a space then:
   "c:\chem32\1\data\demo\demodad.d".
   Note that the path may be different for your ChemStation. The busy indicator should be displayed as the file is loaded into memory.

4) Look up the following commands and determine their function and syntax.
   - LoadSpectrum
   - IdentifyPeaks
   - QuantifyPeaks
   - PumpAll
Tracking Errors and Using some Common Commands

A window can be displayed which will help you track software errors while you are using commands or writing/using macros. The window is accessed with the ListMessages command.

1) On the command line, type ListMessages On. Notice that a white message box is now displayed. The box can be sized differently by dragging the edges. Cryptic explanations regarding syntax or other errors will be displayed here as they occur.

2) Type the following sequence of commands onto the command line. After each command line, you may either use the Enter key or use the semicolon, ; , and the Enter key at the very end of the list. Note the message display.

```
Delreg chromreg
Loadsignal dad,b,,chromreg
IntegrateObj chromreg[1]
Draw 2,chromreg,6:8
```

3) Move back through the previous commands by using the up and down arrow keys. These keys are useful if a typing error has been made and you don't want to type the entire command over again.
Registers, Objects, and Tables

A register is a place to store data such as chromatograms and signals. The ChemStation uses pre-defined registers such as ChromReg for chromatograms and SpecReg for spectra. The chromatograms and spectra are objects in the registers. If you load a data file containing signals A, B, and C; the ChromReg register will contain three objects. To access data for a specific signal, specify the number of the object in square brackets after the name of the register. For example, ChromReg[2], accesses the second object in ChromReg.

A register is made up of a contents list, a header and one or more objects. Each object has a header, a data matrix and possibly one or more tables.

In this exercise, you will learn how to obtain information stored in the pre-defined registers and objects.

Registers

1) Get the contents of the register as follows: Type on the command line

   Contents$=RegCont$(ChromReg) <enter>

   Print Contents$ <enter>.

2) To find out how many objects are in a register, type:

   Size=RegSize(ChromReg)<enter>

   Print  Size <enter>

3) To delete the register as well as the contents, type:

   DelReg ChromReg <enter>
Objects

Objects are the data you work with such as chromatograms or spectra. Each object has a header which contains a description of the object. For instance, if the object is a chromatogram, the header contains the injection time and date, the operator name and vial number.

Objects will also have a data block. The data block is the actual x and y data points that describe the chromatogram or spectrum.

Objects may also comprise tables. Tables are made of a series of rows and columns which typically hold information about the object. An example of a table would be the IntResults table created after chromatograms are integrated. The rows indicate the number of integrated chromatographic peaks and the column names include retention time, area, peak height, and etc…. Tables also have an associated table header. The IntResults table header will tell you how many rows are in the table, thus how many integrated peaks.

Use the following commands to load objects into registers, access the information from the object header, access data points from the data block, and retrieve information from tables. In the following example, you will load a chromatographic signal into ChromReg, integrate the chromatogram, then access information from the object header, data block and IntResults table.

**Loading a chromatogram into a Register as an Object**

1) Load a data file into memory:

   `File c:\chem32#\data\demo\demodad.d <enter>`
   
   where # is your instrument number.

2) Load the chromatographic signals into the ChromReg register by typing:

   `LoadSignal ,,ChromReg <enter>`

3) To view the first of three chromatograms loaded type:

   `Draw 2,ChromReg[1] <enter>`
4) To integrate the chromatogram, use the command `IntegrateObj`. Type:

   ```plaintext
   IntegrateObj  ChromReg[1] <enter>
   Draw 2,ChromReg[1]<enter>
   ```

5) Access scalar variables (numbers) from the object header using `ObjHdrVal`. To obtain the vial number which is stored in the object header type:

   ```plaintext
   VialNum=ObjHdrVal(ChromReg[1],"vial") <enter>
   Print VialNum <enter>
   ```

6) To add more clarity in a macro you may modify the above to:

   ```plaintext
   Print "The vial number is",VialNum <enter>
   ```

   **Note:** The vial number is zero in this case. The data was originally acquired on a 1090 which does have a zero vial position.

7) Access string variables (text) in the object header with the function `ObjHdrText$`. Note that the variable name for a string variable must end in the $ sign. Try obtaining the signal description.

   ```plaintext
   Signal$=ObjHdrText$(ChromReg[1],"signalDesc") <enter>
   Print Signal$ <enter>
   ```

8) To obtain the information as above, you must know the name of the text or scalar variable. There are two functions which can help you obtain this information:

   ```plaintext
   ObjHdrName$(Register,Index)
   ```

   retrieves the item name from the object and

   ```plaintext
   ObjHdrType(Register, Item$)
   ```

   determines if the object is a string, scalar, or table variable.
Lab Exercise: Commands
Registers, Objects, and Tables

Try typing:

Item$=ObjHdrName$(ChromReg[1],3) <enter>
Obtype=ObjHdrType(ChromReg[1],item$) <enter>
Print "Item 3 in object 1 is called","Item$","and is a","Obtype","variable" <enter>

Note: The answer to your print appears above the command line. 0 is a string variable.

Data Matrix

To complete the next section, you will need to load the method, democal1.m, load the data file, demo005_0101.d, and print a report. Do these tasks now.

1) To obtain the actual x and y coordinates of a chromatogram or spectrum, use the Data(Register,axis,datapoint) function. Type:

Timeof3rddatapoint=Data(ChromReg[1],0,3) <enter>
where 0 indicates the x-axis
Print Timeof3rddatapoint <enter>
Absorbanceof20thdatapoint=Data(ChromReg[1],1,20) <enter>
where 1 specifies the y-axis
Print Absorbanceof20thdatapoint <enter>

2) Reference a time value in the chromatographic signal directly using the DataIndex function. You can use the index number to retrieve the absorbance data at a given time.

Index=DataIndex(ChromReg[1],5.0)
Absorbance=Data(ChromReg[1],1,Index)

The above commands obtain the data index at time 5.0.
Use the print command to access the values obtained.
Tables

1) You have already integrated the chromatogram with the IntegratObj command. When each signal is integrated, the integration results are stored in a table called Intresults. One IntResults table is created for each integrated signal and the table is stored in the same object as the corresponding signal. When you quantify the peaks, the integration tables in ChromReg are identified and quantified. The quantification results are stored in tables found in the ChromRes register. ChromRes holds the compound and quantification data for the entire analysis in the first object.

Some of the information you need may be stored in the table header, for instance, the number of integrated peaks in the chromatogram. Two functions can help you access information in table headers:

\[ \text{TabhdrVal(RegObj,TabName,ItemName)} \]
gets a single numeric item from the table header and

\[ \text{TabhdrTextS(RegObj,TableName,ItemName)} \]
gets a single text item from the table header.

Type:

\[ \text{pks=tabhdrval(ChromReg[1],"intresults",numberofrows)<enter>} \]
\[ \text{Print pks <enter>} \]

The number of rows in the intresults table indicates the number of integrated chromatographic peaks.

2) To obtain information directly from the table use:

\[ \text{TabTextS(RegObj,TabName,RowIndex, ColName)} \]
to get a single text element from a table.

Or

\[ \text{TabVal(RegObj,TabName,RowIndex,ColName)} \]
Lab Exercise: Commands

Registers, Objects, and Tables

to obtain a single numeric element from a table.

Type:

\[ \text{pk\_width=tabval(ChromReg[1],"intresults",2,"width") <enter> } \]
\[ \text{Print pk\_width <enter> } \]

You obtained the peakwidth of the second integrated chromatographic peak.

3) Use the commands to obtain the name of the 4th compound from the quantification results table "compound" found in the ChromRes register. To get this information, you must print a report first. By doing this, the variables will be stored in ChromRes. Print a report now if you haven’t already done so.

\[ \text{Name$=Tabtext$(ChromRes,"compound",4,"name")<enter> } \]
\[ \text{Print Name$ <enter> } \]

To obtain the quantified amount for the compound use a different column name to access the same table.

\[ \text{Amount=TabVal(ChromRes,"compound",4,"amount") <enter> } \]
\[ \text{Print Amount <enter> } \]

4) To access the compounds retention time, you will need to reference the "peak" table in ChromRes. You cannot simply use reference index "4" because there are more integrated chromatographic peaks than in the "compound" table. Type the following to obtain the retention time:

\[ \text{FirstPeak=TabVal(ChromRes,"compound",4,"FirstPeak") <enter> } \]
\[ \text{RT=TabVal(ChromRes,"peak",FirstPeak,"MeasRetTime") <enter> } \]
\[ \text{Print RT <enter> } \]
Viewing Tables

Often, you will need to display the contents of a table to understand what row or column to access. EdTab is a useful command.

1) Type:

\[ \text{EdTab 3,ChromRes,Peak<enter>} \]

where 3 is the window number, ChromRes is the Register and Peak is the table. Scroll to view all entries.
Lab Exercise: Commands

Registers, Objects, and Tables
Lab Exercise: Macro Writing
In this Laboratory You Will:

- Write and execute a macro.
- Learn how to find errors in a macro.
- Add a macro to your method and execute that macro.
Writing and Executing a Macro

During this first exercise, you will simply follow the directions to create and execute a simple macro.

1) Minimize the ChemStation. From the Start button, select All Programs then Accessories, and Notepad.

2) Type in the following simple macro:

   Name Class
   File “c:\chem32\1\data\demo\005-0101.d”
   If RegSize(ChromReg)>0 then
   DelReg ChromReg
   Endif
   LoadSignal dad,a,,ChromReg
   IntegrateObj ChromReg
   SetWinTitle 1, "Class Chromatograms"
   Draw 2, ChromReg
   EndMacro

3) Under the File menu, select Save As. Save the file as a text document c:\chem32\core\class.mac.

   Note: Your path statements may be different than the example depending on the drive used for Chem32 and the instrument number.

4) Minimize Notepad and restore the ChemStation.

5) Now, set error detection. On the command line type:

   ListMessages On

   Question:
   What are other ways you can debug a macro?

6) To test the macro, type on the command line:
Lab Exercise:  Macro Writing
Writing and Executing a Macro

Macro class.mac,go

The macro should begin executing. If a problem is found, correct the macro and re-execute.

Note: If the ChemStation cannot open the file, class.mac, go to the directory and check the file extension. Notepad may put a .txt after the .mac extension by default. Rename the file to class.mac.
Write Your Own Macro

Write a macro to do the following. Use your own registers and windows 2-10:

- Get a file from your sequence.
- Obtain signal B.
- Get another file from your sequence.
- Draw the overlaid signal to a full page window.
- Send to the printer with the message: "Overlaid Chromatographic Signals".

Hint: You will need to access the _Config register.
Lab Exercise: Macro Writing

Possible Answer

name overlaid
file "c:\chem32\1\data\demo\005-0101.d"
if regsize (myreg) >0
delreg myreg
endif
loadsignal dad,a,,myreg
file "c:\chem32\1\data\demo\005-0102.d"
loadsignal dad,a,,myreg
draw 2,myreg
settabtext _config [1],window,3,"destination","printer"
settabval _config [1],window,3,defwyhigh,0.6
settabval _config [1],window,3,defwylow,0.1
opendevice "printer" as #5
print #5,"Overlaid Chromatograms"
draw 3,myreg
Close #5
settabtext _config [1],window,3,"destination","screen"
settabval _config [1],window,3,defwyhigh,1
settabval _config [1],window,3,defwylow,0
endmacro

Note: Any two data files may be used in the example.
Notices

© Agilent Technologies, Inc. 2006, 2007
No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.
Microsoft ® is a U.S. registered trademark of Microsoft Corporation.

Manual Part Number
G2170-90041

Edition
02/07
Printed in Germany
Agilent Technologies
Hewlett-Packard-Strasse 8
76337 Waldbronn, Germany

Software Revision
This guide is valid for B.03.xx revisions of the Agilent ChemStation Getting Started with New ChemStation Workflow software, where xx refers to minor revisions of the software that do not affect the technical accuracy of this guide.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
In This Guide...

In analytical laboratories, chromatography data need to be acquired efficiently in a short time. Clarifying ambiguous results can be time-consuming, and may result in high administrative costs. Since ChemStation Revision B.02.01, data storage and data browsing capabilities have been improved to enable fast review and reprocessing of result data.

In this manual, the efficient use of the new data storage and retrieval functions in ChemStation B.02.01/B.03.01 to boost your lab’s productivity are described.

1 ChemStation Data Structure

This chapter gives an overview of the differences between the data structure used in ChemStation revisions prior to B.02.01 and the new data structure in revision B.02.01 and its successors.

2 Data Acquisition

This chapter explains how the new data structure influences the workflow for the acquisition of data for sequences and single runs.

3 Data Analysis

This chapter outlines the data analysis and review options that are available, and explains how consideration of the data structure affects your choice of options.

4 Workflow with Unique Folder Creation switched off

This chapter provides information on working with Unique Folder Creation switched off which allows you to store data as in ChemStation revisions B.01.03 or earlier. This mode does not take full advantage of the latest data review and reprocessing functionality in ChemStation.
Contents

1 ChemStation Data Structure  7
   ChemStation prior to B.02.01  8
   ChemStation B.02.01/B.03.01  9

2 Data Acquisition  13
   Data Acquisition  14
      Data Acquisition in a Sequence  15
      Data Acquisition of Single Runs  17

3 Data Analysis  19
   Data Analysis  20
   Data Analysis: Data Review  23
      The ChemStation User Interface during Data Review  29
   Data Analysis: Reprocessing data  31

4 Workflow with Unique Folder Creation switched off  35
   Working with Unique Folder Creation on or off?  36
   Workflow with “Unique Folder Creation” switched off  37
Contents
This chapter gives an overview of the differences between the data structure used in ChemStation revisions prior to B.02.01 and the new data structure in revision B.02.01 and its successors.
ChemStation prior to B.02.01

In ChemStation revisions prior to B.02.01, sequences, methods and the generated data files and results were stored in fixed, specified and separated locations. For example, methods were referenced by name in a sequence and it was the user’s responsibility to maintain the integrity of methods, sequences, and data files. Because of this, the long-term archiving of data, and reproduction of results was a tedious task. Users had to document the chromatogram, results, and associated method; this was the case not only for regulated labs, but also for some areas of unregulated labs (such as environmental labs). In ChemStation prior to B.02.01, this could be achieved only by printing everything in a report.
In order to strengthen the association between data files and methods, the following new data organization scheme has been implemented with ChemStation B.02.01/B.03.01. When used with the ChemStation, the Agilent Enterprise Content Manager (ECM) also makes use of the new data concept, since the complete data set (sequence/methods/data files) can now be transferred (archived) to ECM as one entity.

The methods in the folder Chem32\1\methods serve as master methods, i.e. during acquisition and data analysis, they remain unchanged.
Similarly, the sequences in the folder Chem32\1\sequence serve as sequence templates that can be used to rerun (but not reprocess) a sequence several times.

The data storage pattern varies depending on whether single run data or sequence data is acquired:

1. When a sequence is executed, a new folder is automatically created ("sequence container") with a unique name in the specified subdirectory. When a single sample is run, the data file (*.d) is written to the specified subdirectory.

2. For sequence data, the executed sequence template (*.s) and all the methods (*.m) involved are copied into the sequence container. The copies of the methods are called the “sequence methods” in order to distinguish them from the original master methods.

   All sequence-related tasks (e.g. acquisition and data analysis) are performed on the copies of the sequence and the methods. Therefore, the sequence template and the master methods remain unchanged for future sequence execution.

   While executing the sequence, all generated data files (*.d) are stored in the sequence data folder, along with the corresponding batch file (*.b) and sequence log file (*.log).

3. Each data file contains two copies of the method used to create the run.
   - The first one, called ACQ.M, is saved directly after the acquisition part of the method is completed.
   - The second copy, called DA.M, is saved after completion of the data analysis part.

The preservation of the state of the method at acquisition of the specific data file is thus ensured. The acquisition parameters can be viewed and printed in Data Analysis view. The DA.M can be modified during data analysis. In this case, these two methods may differ if, for example, the calibration table is updated.
The following chapters explain the impact of this structure on typical workflows in more detail. The corresponding settings in the ChemStation dialogs are also shown.
1 ChemStation Data Structure

ChemStation B.02.01/B.03.01
This chapter explains how the new data structure influences the workflow for the acquisition of data for sequences and single runs.
Starting with ChemStation B.02.01, flexible data storage for single runs and sequences allows you to specify various saving locations without reconfiguration. The Paths tab in the Preferences dialog box in the View menu gives you the opportunity to add multiple paths in addition to the default path C:\chem32\x\DATA (where x is the instrument number). Using the Add and Remove buttons, existing paths can be simply deleted, or you can navigate to a selected location and add the path to the new location into the Preferences. The default path cannot be removed from the list, but it can be changed in the Configuration Editor.

![Figure 2: Preferences Dialog / Paths Tab](image)

All newly specified Data Paths are then available for selection in the Sample Info/Sequence Parameters dialog boxes when performing runs.
Data Acquisition in a Sequence

In order to run a sequence, appropriate pre-defined methods must be available. These are the master methods as outlined above. Typically, master methods and sequence templates are worked on in the Method and Run Control view of the ChemStation. For this reason, in Method and Run Control view, the ChemStation Explorer provides access to master methods and sequence templates.
The sequence template references these methods in the sequence table.

As explained previously, when a sequence is run with sequence template
<sequence_name>.S, and the master method <method_name>.M is used, a new
folder is created that contains all resulting files from the sequence run
(“sequence container”).

The location of this folder is determined by the settings in the Sequence
Parameters dialog box; the naming of this folder is determined by the
Sequence tab of the Preferences dialog box. By default, the name is
<sequence_name> <acquisition_date> <acquisition_time>, but it can be
configured by using the tokens Operator, Instrument, Counter, and PC Name,
or you can manually enter any name. If the Name Pattern would not result in
unique names for the sequence containers, the ChemStation will append a
counter to ensure uniqueness.

![Preferences Dialog / Sequence Tab](image)

**Figure 4** Preferences Dialog / Sequence Tab

At the start of an acquisition sequence, the method specified in the sequence
table is copied from the master methods folder into the sequence container. In
addition, a copy of the sequence is created and placed with the sequence log
and the batch (*.b) file in the sequence container. All updates of the method
(e.g. updates of the calibration table) are written to this sequence method in
the container. All necessary files are now available for future data review and reprocessing, without changes that were applied to the master method or sequence template for other sequence runs.

During acquisition, the data files are stored to the sequence container. Within each data file (*.D), two additional methods, ACQ.M and DA.M, are saved for this specific run. These two methods are copies of the sequence method, preserving the state of the method as it was at the time of acquisition of the specific data file. In the case of e.g. calibration table updates the DA.M methods differ for each of the runs.

The individual acquisition method ACQ.M is intended to preserve the acquisition parameters, therefore it is recommended that you do not change this method during future data review activities. In Data Analysis view, the acquisition parameters of this method can be viewed and printed.

With these files saved in the sequence folder, all data review and reprocess activities can be performed without altering the master method or the sequence template. If needed, method changes can also be saved to the master method again.

**Data Acquisition of Single Runs**

The new data concept is also introduced for single runs. In this case the data file is saved directly into the respective subdirectory. Since only one method is employed for a single run, this method does not need to be copied into the subdirectory; all actions are performed directly with the master method. After the acquisition part of the method is completed a copy of the master method is saved into the data file directory (ACQ.M). Another copy (DA.M) is saved after the data analysis part of the master method has been executed.
This chapter outlines the data analysis and review options that are available, and explains how consideration of the data structure affects your choice of options.
Once the data have been acquired, they can be analyzed in ChemStation Data Analysis view. When selecting the Data tab of the ChemStation Explorer, you can load all the runs of a sequence or all single runs in a specific folder by double-clicking the corresponding symbol. The corresponding data set is then available in the Navigation Table.

The main body of the Navigation Table consists of a list of all runs of the set. Instead of loading a run via the File / Load Signal menu, a run can now be loaded into ChemStation memory by double-clicking the relevant line in the Navigation Table. Additionally, a right-click on a run offers several options, e.g. to load or overlay specific signals from the file, to export the data, or to view the acquisition method parameters.

Once the run is loaded, you can review it, i.e. adjust data analysis parameters, integrate the signals and finally print a report. In this case you analyze the run as a single run without taking the sequence context into account.

This way of data analysis is called “Data Review”. The Navigation Table provides the tool set shown in Figure 6, which makes data review more convenient.
With this toolset, you can jump to the beginning or end of the Navigation Table, step on to next or previous run, automatically step through the runs, and stop automatic stepping.

A different way to analyze your data is to “Reprocess” a complete sequence. During this process, all runs are reanalyzed in the sequence context, i.e. the calibration tables of the sequence methods are updated in the case of calibration runs, multipliers, amounts etc. can be changed in the sequence table, new methods can be added to the sequence container, etc. For reprocessing, the Navigation Table provides the following toolset:

![Figure 7](image)

**Figure 7** Sequence Reprocessing Toolset of the Navigation Table

Note that the reprocessing icons in the Navigation Table are available only for sequence data generated with ChemStation B.02.01 and higher. For Single Run data, for data generated prior to B.02.01, and for data acquired while Unique Folder Creation is switched off (see Chapter 4, “Workflow with Unique Folder Creation switched off”), reprocessing in Data Analysis is not accessible.

Sequences acquired prior to B.02.01 need to be reprocessed in “Method and Run Control”, defining the sequence parameter “parts of method to run” to “reprocess only”. For sequences generated with ChemStation B.02.01 and higher, the reprocessing option in Method and Run Control has been removed (see Figure 8 on page 22), and the Navigation Table offers reprocessing as a Data Analysis Task.
3 Data Analysis

Data Analysis

**Figure 8** Sequence Parameters in Method and Run Control view of ChemStation B.02.01 and higher
Data Review means analyzing on a run-per-run base. ChemStation allows you to specify default actions that are performed automatically when a data file is loaded from the Navigation Table. These include data analysis tasks like integrating the chromatogram directly after loading, and also specifying the method that is to be loaded.

The corresponding options for reviewing (not used for reprocessing) are set up on the “Review/Signal Options” tab of the Preferences dialog box.

The first section, “Load Signal Options”, specifies which of the signals in a run are loaded, and if the chromatograms are to be integrated and the results reported directly after loading.

In the second section, “Data Review Options”, you have the possibility to configure the interval for stepping through the runs in the Navigation Table automatically.
The remainder of this section specifies which method is loaded during data review when a run is loaded from the Navigation Table. They only apply to data review, but not to reprocessing. The following separate option sets are available for sequence runs and single runs:

### Table 1  Data Review Options for Sequence and Single Run Data

<table>
<thead>
<tr>
<th>Method used for review of sequence data</th>
<th>Method used for review of single run data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Method</td>
<td>Current Method</td>
</tr>
<tr>
<td>Sequence Method</td>
<td>Individual method from data file (DA.M)</td>
</tr>
<tr>
<td>Individual method from data file (DA.M)</td>
<td></td>
</tr>
</tbody>
</table>

**Keep “Current Method”**

The review setting “Current Method” should always be used when you want to use the method that is currently loaded. In this respect, for data review the current method remains irrespective of which single run data file or sequence container file is loaded. This setting should be used for method development, to create a calibration table or other updates etc. For example, you run a sequence with runs of different concentrations in order to optimize integration parameters, and afterwards build the calibration table. As these changes in data analysis parameters must be available for all future acquisition runs, you have to apply them to the master method. In order to do this, you select the option “Current Method” in the Preferences dialog, see Figure 10. This ensures that, for each run loaded, the same method is always kept in memory.
You load the master method, most conveniently from the Method tab of the ChemStation Explorer.

Now, you optimize the integration parameters and use the runs to construct the calibration table. All future acquisitions using this method will apply these optimized data analysis parameters.

**Load “Sequence Method”**

It may also occur that sequence-specific events require changes in all the methods employed with the sequence. Once every run has been reviewed and the sequence methods have been improved, the complete sequence can be reprocessed with the updated methods.

In this scenario, you review the data using the option “Sequence Method” (see Figure 11).
This means that each time you load a run from the Navigation Table, the sequence method corresponding to the run’s sequence line is loaded.

Once the data review has been completed, it may be necessary to reprocess the complete sequence in order to apply the method changes not only on a run-per-run base, but also in the complete sequence context (including calibration table updates etc.).

**Load “Individual Method from Data File (DA.M)”**

The review setting “Individual Method from Data File (DA.M)” (see Figure 12), should be used, if you want to load the individual DA.M automatically along with the corresponding data file, when this file is loaded using the navigation table. When you change a method and then load the next run, you will be asked to save your method changes, because you load a new method: the DA.M of the next run.

Various workflows may require that you always review data with the individual data analysis method (DA.M) loaded. For example, when all runs are loaded with DA.M, the analysis results are the same as during acquisition.
or last reprocessing. Additionally, it is possible to perform run-specific changes and save them in the individual data analysis method of the run. This is especially useful for manual integration events.

![Preferences dialog box](image)

**Figure 12**  Load the Individual Method from Data File for Data Review

Using the individual data analysis method (DA.M) a convenient means is available to store manual integration events to a specific data file only. So, when you use the automatic review and print the reports, the specific manual integrations are reported in one shot.

Use the following steps to copy manual integration events to a method:

1. Perform manual integration until the results are satisfactory.
2. Select Integration / Copy Manual Events to Method
When the manual events have been saved to the individual method (instead of e.g. the corresponding master method), it is probably most useful always to apply those events when the chromatogram is integrated:

3 Check the “Manual Events” option in the Integration Events dialog (see Figure 14).

4 Save the method.

NOTE When a sequence is reprocessed, all actions are performed on the sequence methods and the DA.M of each data file is overwritten, including the manual integration events.
The ChemStation User Interface during Data Review

The ChemStation user interface provides a number of features to facilitate working with the different methods available for data analysis (Figure 15).

- The method modification status is displayed in Data Analysis view, so you can easily follow if there are unsaved method changes. The user interface always displays the name of the currently loaded method (together with the information whether it is an individual data analysis method of a data file or a sequence method).

- When you move the mouse pointer over this field, a tool tip additionally displays the complete path and name of the method.

- A dropdown box provides a “shortcut” to the method options of the Preferences dialog. You can directly enable any of the available options and it will be applied the next time you load a run from the Navigation Table. Moreover, it is also very convenient to see which option is currently active. Note that these options only apply to data review, but not to reprocessing.

**Update master method feature**

During working on the individual data analysis method, you may decide that you want to have the data analysis parameters you developed for the individual method available for the sequence or master method. A right-click in the Navigation Table on the corresponding run allows you to update your sequence or master method with the data analysis parameters.
This feature is available in the following situations:

**Table 2** Availability of the Update ... Method Functionality

<table>
<thead>
<tr>
<th>Loaded Method</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual data analysis method (DA.M)</td>
<td>Update Master Method</td>
</tr>
<tr>
<td></td>
<td>Update Sequence Method</td>
</tr>
<tr>
<td>Sequence method</td>
<td>Update Master Method</td>
</tr>
<tr>
<td>Master method</td>
<td>—</td>
</tr>
</tbody>
</table>

It is important to note that this feature only updates data analysis parameters of the target method, and that it overwrites all data analysis parameters.

**NOTE** For technical reasons, in addition to the data analysis parameters, the Method Change History of the target method is also overwritten with History of the source method.
Data Analysis: Reprocessing data

In contrast to data review, sequence reprocessing means that all the runs of a sequence are reanalyzed in the sequence context, i.e. including calibration table updates, parameters changes in the sequence table, additions of new methods to the sequence, etc.

With the new data organization concept, the sequence container includes all files needed for reprocessing: the data files, a copy of the sequence file, and all the sequence methods originally employed with the acquisition. Thus, in order to reprocess a sequence you simply have to load it into the Navigation Table and the required tool set is available.

Note the following rules with regard to reprocessing:

- All actions are performed on the sequence methods. If changed analysis parameters are to be applied, you have to change the sequence methods.

- The method loading settings of the Preferences dialog have no influence on reprocessing; it always works on the sequence methods or updated sequence methods. This feature set is valid for reviewing only.

- During reprocessing, the Batch (*.b) file, the sequence/single run log (*.log), the Navigation Table, and the individual data analysis method (DA.M) of each processed data file are updated.

- If you want to add new methods from one of the master method directories to the sequence table, you have to use the Browse item in the list of methods to browse to any specified method directory (only the methods already in the sequence container are available without browsing). The new method is also copied to the sequence container during reprocessing. This implies that you cannot select a method with the same name as a method already present in the container.
3 Data Analysis

Data Analysis: Reprocessing data

In the sequence table, it is not possible to add or remove lines.

In the Sequence Parameters dialog, only the operator name, the sequence comment, and the usage of sequence table information can be changed. All other fields have to be set during data acquisition or do not apply to reprocessing.

Figure 18  Browse to the Master Methods directory in the Sequence Table
Figure 19  Sequence Parameters in Data Analysis
Data Analysis

Data Analysis: Reprocessing data
4
Workflow with Unique Folder Creation switched off

This chapter provides information on working with Unique Folder Creation switched off which allows you to store data as in ChemStation revisions B.01.03 or earlier. This mode does not take full advantage of the latest data review and reprocessing functionality in ChemStation.
The new data concept as outlined in the previous chapters provides a number of advantages:

- Sequence data are not overwritten. Each sequence acquisition stores the resulting data files in its own sequence container with unique name.

- With the sequence container concept, the data are stored with all necessary information needed for data analysis, i.e. copies of the sequence file and of all methods employed with the sequence. These methods can be changed with sequence specific input and do not influence the original master method. The container concept thus strengthens the meaning of a sequence as a set of data files and methods belonging together for result creation.

- Data review and reprocessing are both available in Data Analysis view via the Navigation Table.

- The data container concept provides the optimal preconditions for the ChemStation Integration with the Agilent Enterprise Content Manager (ECM).

However, there may be situations where users may want to store their data as in ChemStation B.01.03 or earlier and work according to the corresponding workflows:

- During method development it may be more convenient to have only one method for both acquisition and data analysis to automatically have changes available for future acquisition and reanalysis of already acquired data.

- Data from several acquisitions have to be in one folder, e.g. in case of partial acquisition.

- Customized macro solutions on a ChemStation system that have been designed for older revisions may require the data, methods, or sequence to be stored according to the old data organization scheme.

- When ChemStation B.03.01 runs in a lab where there are also system still running on ChemStation revisions B.01.03 or earlier, it may be more convenient to use the same data organization mode on all systems.
Workflow with “Unique Folder Creation” switched off

In order to allow working with a data storage concept as in ChemStation revisions before B.02.01, the Sequence tab of the Preferences dialog box a Data Storage section. Here you can choose between “Unique Folder Creation ON” and “Unique Folder Creation OFF” (Figure 20). Per default, “Unique Folder Creation ON” is selected. “Unique Folder Creation ON” enables the data storage concept as outlined in the three chapters above.

![Preferences Dialog / Sequence Tab](image)

**Figure 20** Preferences Dialog / Sequence Tab

**NOTE**

Switching Unique Folder Creation on or off only affects future acquisitions, but does not change the data organization of already acquired data.
Workflow with “Unique Folder Creation” switched off

NOTE

We recommend to decide between the two modes at the beginning of your work and not to switch between them.

Switching Unique Folder Creation off is not supported with the ChemStation ECM Integration or ChemStore/Security Pack installed.

Selecting “Unique Folder Creation Off” has the following impact on data storage:

- Sequence data are not acquired into a sequence container, but directly into the subdirectory as specified in the Sequence Parameters (Figure 3 on page 15). Therefore, the sequence name pattern is grayed out on the Sequence tab of the Preferences dialog (Figure 20 on page 37).

- This means that for two or more sequence acquisitions the data may be acquired into the same subdirectory. This implies the risk to overwrite existing data, but on the other hand allows to split sequences using partial sequence execution and still combine the results in one folder (which would not be possible with Unique Folder Creation switched on).

- No sequence methods (.M) or copies of the sequence file (.S) are stored with the data, but only the sequence logfile and the batch file (.B). This means only the methods and sequences in the paths specified in the Preferences dialog (Figure 2 on page 14) are available. They have to be used for acquisition as well as for data review and reprocessing. Sequence or data file specific method changes can only be stored by saving the method with different name. Otherwise these changes are also applied to the acquisition method. On the other hand, this may be desired behavior during method development.
• There are no data file specific methods ACQ.M and DA.M stored. Saving information about the original acquisition is only possible by including this information in the report or by selecting “Save Method with Data” from the method’s runtime checklist (Figure 21). With this option the acquisition method will be stored as RUN.M in each data file.

![Run Time Checklist: Instrument 1](image)

**Figure 21** Run Time Checklist: Save Method with Data
Workflow with Unique Folder Creation switched off

The enhanced ChemStation user interface as introduced with ChemStation B.02.01 is also available when Unique Folder Creation is switched off. However, there are functions you cannot take advantage of in this mode. The same limitations also apply to any run acquired with ChemStation prior to B.02.01.

- When a sequence is loaded into the Navigation Table, the reprocessing toolset is grayed out (Figure 22). Sequences that have been acquired in this data storage mode can only be reprocessed in Method and Run Control view using the “Reprocessing only” option in the Sequence Parameters (Figure 23).

Figure 22  Navigation Table for Sequences acquired with Unique Folder Creation switched off

Figure 23  Reprocessing of sequence data acquired with “Unique Folder Creation” off
• With the method usage options “Use method from data file” and “Use sequence method” (see “Data Analysis: Data Review” on page 23), a warning message will be displayed each time a run is double-clicked in the Navigation Table that the individual method/sequence method does not exist. As outlined above, these methods are not stored with the data. In this case, the only meaningful option for data review is “Use current method”.
Workflow with Unique Folder Creation switched off
Workflow with “Unique Folder Creation” switched off
In This Book

With revision B.02.01 of ChemStation, data review and data reprocessing capabilities have been significantly improved to enable fast review of result data.

The new data storage functions in ChemStation help to efficiently organize sequence data and methods.